
 

 

  INFORMATION TECHNOLOGY 

 BCOM (computer Applications) 

 Semester – I, Paper-IC 

 

 

Lesson Writers 
 
 
 
 
 
 
 

Dr. U. Surya Kameswari 
M.Sc.,(CS), M.Tech.(IT), Ph..D., 

 
Dr. G. Neelima 
MCA, M.Tech (CSE), Ph..D., 

 

 

 

 

 

 

Editor 
 

Prof. K. Gangadhara Rao 
 M.Tech., Ph.D., 

                                

 

Director 

Dr. NAGARAJU BATTU 
MBA., MHRM., LLM., M.Sc. (Psy).,MA (Soc)., M.Ed., M.Phil., Ph.D 

CENTRE FOR DISTANCE EDUCATION  
ACHARAYA NAGARJUNA UNIVERSITY 

NAGARJUNA NAGAR – 522 510 

 

Ph: 0863-2293299, 2293214, Cell: 9848477441 

0863-2346259 (Study Material) 

Website: www.anucde.info 

e-mail:anucdedirector@gmail.com 

http://www.anucde.info/
mailto:anucde@yahoo.com


 

B.COM (Computer Applications) 

 
First Edition : 2021 

No. of Copies : 

 
(C) Acharya Nagarjuna University 

 

 

 

This book is exclusively prepared for the use of students of Three-Year BA/BCOM 

(computer Applications), Centre for Distance Education, Acharya Nagarjuna University 

and this book is meant for limited circulation only. 

 

 

 

 

 

 

Published by : 

Dr. NAGARAJU BATTU, 
Director 

Centre for Distance Education, 

Acharya Nagarjuna University 

 

 

 

 

 

 

 
Printed at : 



 

 

 

 

 

Since its establishment in 1976, Acharya Nagarjuna University has been forging ahead 

in the path of progress and dynamism, offering a variety of courses and research 

contributions. I am extremely happy that by gaining a B++ (80-85) grade from the 

NAAC in the year 2003, the Acharya Nagarjuna University is offering educational 

opportunities at the UG, PG levels apart from research degrees to students from over 

285 affiliated colleges spread over the three districts of Guntur, Krishna and 

Prakasam. 

The University has also started the Centre for Distance Education with the aim 

to bring higher education within reach of all. The centre will be a great help to those 

who cannot join in colleges, those who cannot afford the exorbitant fees as regular 

students, and even housewives desirous of pursuing higher studies. With the goal of 

brining education to the doorstep of all such people, Acharya Nagarjuna University 

has started offering B.A., and B.Com courses at the Degree level and M.A., M.Com., 

M.Sc., M.B.A., and L.L.M., courses at the PG level from the academic year 2003-2004 

onwards. 

To facilitate easier understanding by students studying through the distance 

mode, these self-instruction materials have been prepared by eminent and experienced 

teachers. The lessons have been drafted with great care and expertise in the stipulated 

time by these teachers. Constructive ideas and scholarly suggestions are welcome from 

students and teachers involved respectively. Such ideas will be incorporated for the 

greater efficacy of this distance mode of education. For clarification of doubts and 

feedback, weekly classes and contact classes will be arranged at the UG and PG levels 

respectively. 

It is my aim that students getting higher education through the centre for 

Distance Education should improve their qualification, have better employment 

opportunities and in turn facilitate the country’s progress. It is my fond desire that in 

the years to come, the Centre for Distance Education will go from strength to strength 

in the form of new courses and by catering to larger number of people. My 

congratulations to all the Directors, Academic Coordinators, Editors and Lesson- 

writers of the Centre who have helped in these endeavors. 

Prof. P. Raja Sekhar 
Vice-Chancellor 

Acharya Nagarjuna University 
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INFORMATION TECHNOLOGY 

I Year B Com (CA), Semester – I, Paper-I 

Syllabus 

Objectives: 
1. To help students become literate in the fundamental understanding of information 

technology (IT) 

2. Give students a basic understanding of basic concepts and terminology of information 

technology and be able to define them and have a basic understanding of personal 

computers and their operations 

3. To provide hands-on use of Microsoft Office 2007 applications Word, Excel and 

PowerPoint. 

 

Unit-I  

Introduction computers: Computer Definition - Characteristics and Limitations of Computer, 

Generations of Computer, Classification of Computers, Applications of Computer, Hardware − 

Basic organization of Computer - Input and Output Devices 

 

Unit- II (Understanding computer memory and software) 

Memories: primary, secondary and cache memory, Software: types of software, system software, 

Application software, commercial software, open source software, domain software and free ware 

software, Programming Languages: Introduction to Programming Languages − Generations of 

Programming Languages 

 

Unit- III Get in touch with Word Processing (MS word) 

Features of MS Word - Parts of Word Window − Creating, Saving, Opening document, Printing, 

Formatting: Formatting of Text and Paragraph - Bullets and Numbering - Editing - Moving and 

Copying - Find and Replace Text − Tables: Creating tables, inserting and deleting rows and 

columns, Insertion of pictures − Insertion of clipart - Mail Merge 

 

Unit-IV Working with MS Excel 

Features of Excel, Parts of Excel window, Workbooks, Creating, Opening and Saving a Workbook, 

Worksheets, rows, columns, Inserting and Deleting rows and columns, cells, Entering labels, 

values, and formulas in worksheet, Formatting: Adjusting row height and column width - 

Formatting cell values, Formulas and Functions: operators used in formula, cell references in 

formula, Mathematical, Statistical, Logical and Text functions, Charts: Different types of charts, 

Creating a chart 

 

Unit-V MS Power point 

Features of PowerPoint, Parts of PowerPoint window, creating, saving and opening presentation, 

working with slides: Inserting, deleting, copying slides, editing text, formatting text, Formatting 

and Modifying Presentations: Applying transition and animation to the slides, inserting music or 

sound on a slide, viewing slide show 

 

 



 

 

 

Books for study and reference: 

1. P.Mohan computer fundamentals- HimalayaPublications. 

2. R.K.Sharma and Shashi K Gupta, Computer Fundamentals - Kalyani Publications 

3. Fundamentals of Computers ByBalagurusamy, Mcgraw Hill 

4. Fundamentals of Computers Rajaraman V Adabala N 

5. MS-Office S.S. Shrivastava 

6. Microsoft Office 2007 Fundamentals, 1st Edition By Laura Story, Dawna Walls 
 

Online Resources: 

1. https://support.office.com/en-us/office-training-center 

2. https://www.skillshare.com/browse/microsoft-office 

3. https://www.tutorialspoint.com/computer_fundamentals/i 

4. ndex.htm https://www.javatpoint.com/computerfundamentalstutorial 

5. https://edu.gcfglobal.org/en/subjects/office/ 

6. https://www.microsoft.com/en-us/learning/training.aspx 
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LESSON- 1 

INTRODUCTION TO COMPUTERS 

AIMS AND OBJECTIVES 

In this unit the student can recognize the importance of computer literacy, describe the 

categories of computers, and discuss various computer applications in society. After 

completing this chapter you will be able to explain why computer literacy is vital to success 

in today's world, define the term computer, and differentiate among types, sizes and functions 

of computers. 

 

STRUCTURE 

1.1 Introduction 

1.2 Computer Definition 

1.3 Characteristics of a Computers 

1.4 Limitation of a Computer 

1.5  Generations of a Computer 

 1.5.1 First generation 

 1.5.2 Second Generation 

 1.5.3 Third Generation 

 1.5.4 Fourth Generation 

 1.5.5 Fifth Generation 

1.6 Classification of Computers 

 1.6.1 Super Computer 

 1.6.2 Mainframe Computer 

 1.6.3 Mini Computer 

1.6.4  Micro Computer 

1.7 Applications of Computers 

1.8 Summary 

1.9 Technical Terms 

1.10 Self-Assessment Questions 

1.11 Suggested Readings 
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1.1 INTRODUCTION 

Our lifestyle has undergone a sea change with the advancement of technology 

especially in the field of computer. Computers are an integral part of our lifestyle today and 

can be found in offices, homes, schools, colleges, hotels, shops, etc. This advancement of 

technology has made our lives easier and more comfortable. Computers can simplify tasks 

such as word processing, designing, website development, and database management. 

Computer is an advanced electronic device that takes raw data as input from the user 

and processes it under the control of set of instructions (called program), gives the result 

(output), and saves it for the future use. A computer system is made up of both hardware and 

software. Software is another term for computer program. Software controls the computer 

and makes it do useful work. Without software a computer is useless. Hardware refers to the 

physical components that make up a computer system. These include the computer's 

processor, memory, monitor, keyboard, mouse, disk drive, and printer and so on. 

 

1.2  COMPUTER - Definition 

 Computer is derived from the Latin keyword computare which means to calculate. In 

early days, the computer was originally developed to create a fast calculator. However, today, 

computer is used for purposes other than mathematical or calculation activities. 

A computer is an electronic device that controls instructions stored in its own 

memory, which can accept data, process data according to specified instructions, generate 

output, and store the output for future reference. 

 Computers process data into information. Data is a collection of unprocessed items, 

which can include text, numbers, images, audio, and video. Information conveys meaning 

and is useful to people. 

 

1.3  CHARACTERISTICS OF A COMPUTER 

1.3.1 Speed 

We know that Computers are work very fast. It takes only few seconds for calculations that 

we take hours to complete. we determine the speed of computer in terms of microsecond (10-6 

part of a second) or nano-second (10-9 part of a second).  

1.3.2 Accuracy 

Suppose someone calculates faster but commits a lot of errors in computing. Such result is 

useless.  The degree of accuracy of computer is very high and every calculation is performed 

with the same accuracy. The accuracy level is determined on the basis of design of computer. 

The errors in computer are due to human and inaccurate data. 
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1.3.3 Diligence 

A computer is free from tiredness, lack of concentration, fatigue, etc. It can work for hours 

without creating any error. If millions of calculations are to be performed, a computer will 

perform every calculation with the same accuracy. Due to this capability it overpowers 

human being in routine type of work. 

1.3.4 Versatility 

It means the capacity to perform completely different type of work. We can use our 

computers for different tasks randomly with any complexity. 

 1.3.5 Power of Remembering 

Computer has the power of storing any amount of information or data. Any information can 

be stored and recalled as long as you require it, for any numbers of years. It depends entirely 

upon you how much data you want to store in a computer and when to lose to retrieve these 

data. 

1.3.6 Storage 

The Computer has an in-built memory where it can store a large amount of data. You can also 

store data in secondary storage devices such as floppies, which can be kept outside your 

computer and can be carried to other computers. 

 

1.4 LIMITATIONS OF A COMPUTER 

Even though, a computer system performs various services to its users, it also suffers from 

the following limitations. 

 The computer can only do things that are designed or programmed. If you ask a 

computer to get full payroll for a certain period of time, it will only give you total 

payroll and not the net salary or gross salary of each employee. 

 

 It does not correct the input data. If you enter incorrectly at the rate of 50 per hour, 

the computer will not respond at the rate of 40 per hour. 

 

 It does not think and derives meanings from objects. The computer does not 

understand your favorite topic or your current state of mind. 

 

 It can only process jobs that are expressed in several steps leading to a precisely 

defined goal. 

 

 It does not completely prevent faults due to power fluctuations, system 

malfunction and human disorders. 
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 Computers do not have the necessary skills. They must be pre-programmed so that 

decisions can be made. 

 

 Computers are machines with a zero IQ. They cannot think for themselves and 

need to be directed to every step. 

 

 Although we have succeeded in building memory for the computer, no computer 

is equal to the human heart and soul. 

1.5  GENERATIONS OF A COMPUTER 

The tem generation indicates the type of technology used in the computer construction. As 

new technology was emerging, it was being used in the making of computer. The new 

technology improved the speed, accuracy and storage capacity of the computers. Different 

technologies have been used for computers in different times.  

Therefore, computers can be divided into five generations depending upon the technologies 

used. These are: 

1. First Generation (1945 - 1956) 

2. Second Generation (1956 - 1963) 

3. Third Generation (1964 – 1971) 

4. Fourth Generation (1971 - Present) 

5. Fifth Generation (Present and beyond) 

1.5.1 First Generation Computers (1945 – 1956) 

The vacuum tube technology was used in first-generation computers. Mark-1m, ENIAC, 

EDSAC, EDVAC, UNIVAC-1 etc. machines belong to the first generation of computers. The 

machine language only was used in first-generation computers. 
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Advantages 

The main advantages of first-generation computers were: 

1. These computers were the fastest of their time. 

2. They were programmed using machine language. 

3. The electronic digital computers were introduced due to the vacuum tube technology. 

Disadvantages 
The main disadvantages of first-generation computers were: 

1. Very big in size 

2. Not reliable 

3. Consumed large amount of energy 

4. Constant maintenance required 

5. More heat generated and air-conditioning was required 

6. More costly 

7. Very slow in speed (data processing) 

8. It was difficult to programmed, because they used only machine language 

9. Non-portable 

10. Limited commercial use 

1.5.2 Second Generation Computers (1956 – 1963) 

The transistor technology was used in second-generation computers. The electronic 

component transistor was invented in 1948 at Bell Laboratories. The transistor is smaller in 

size and more reliable than vacuum tube. Therefore, the transistor technology was used in 

computer in place of vacuum tube technology. The programming assembly language was also 

introduced in second-generation of computers. 

 

Advantages 

The main advantages of second-generation computers as compared to first-generation 

computers are: 
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1. Low in cost 

2. Smaller in size 

3. Fast in speed 

4. Less heat generated More reliable and accurate in calculations 

5. Consume low power etc. 

6. Used for commercial purposes 

7. Portable 

8. Assembly language was introduced. This language is easy to write program than 

machine language 

Disadvantages 

The main disadvantages of this generation computers were: 

1. Air-conditioning required 

2. Commercial production was difficult and these were very costly 

3. Constant (or frequent) maintenance required 

4. Only used for special purposes 

 

1.5.3 Third Generation Computers (1964 – 1971)  

The IC (Integrated Circuits) technology was used in third-generation computers. In a small 

IC chip (5 mm square size) a circuit is designed having large number of electronic 

components like transistors, capacitors, diodes, resistors etc. Initially, an IC contained only 

about ten to twenty components. Thus the IC technology was named as Small Scale 

Integration (SSI). The third-generation was based on IC technology and the computers were 

designed using this technology. 

 

Advantages 

The main advantages of third-generation as compared to previous generations of computers 

were: 

1. Smaller in size 

2. Production cost was low 

3. Very fast in computational power 

4. More reliable 

5. Low power consumption 
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6. Maintenance cost was low because failure rate of harware was very low 

7. Magnetic disk, used for externale storage 

8. More storage capacity 

9. Easily portable 

10. Easy to operate 

11. Upgraded easily 

12. Widely used for various commercial applications all over the world 

13. Lower heat generated 

14. High-level languages were commonly used 

15. Many input/ouput devices were introduced such as mouse and keyboard etc. 

Disadvantages 

The main disadvantages of thir-generation computers were: 

1. Air-conditioning required 

2. Highly sophisticated technology required for the manufacturer chips 

 

1.5.4 Fourth Generation Computers (1971 – Present) 

The microchip technology was introduced in this generation of computers. With the 

advancement in IC technology, LSI (Large Scale Integration) chips were developed. It was 

possible to itegrate over 30,000 or more components on to single LSI chip. After LSI, the 

VLSI (Very Large Scale Integration) was developed and the development of microprocessor 

possible. It is expected that more than one million components will be integrated on a single 

chip of VLSI. Using VLSI technology, the entire CPU is designed on a single silicon chip. 

The use of microprocessor as CPU introduced another class of computers called the 

microcomputers. Thus fourth-generation may be called Microcomputer generation. IBM 

introduced its personal computer for use in 1981. 

 

Advantages 

The advantages of fourth-generation as compared to previous generation computers are: 

1. Smaller in size 

2. Production cost is very low 

3. Very reliable 

Intel 4004 chip 
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4. Harware failure is negligible 

5. Easlity portable because of their small size 

6. Totally general purpose 

7. Air conditioning is not compulsory 

8. Very high processing speed 

9. Very large internal and external storage capcity 

10. Used advanced input & ouput devices such as optical readers, laser printers, CD-

ROM/DVD-ROM drives etc. 

Disadvantages 

The main disadvantages of fourth-generation computers is: 

1. Highly sophisticated technology required for the manufacturer of microprocessor 

chips 

1.5.5  Fifth Generation Computers (In process) 

The main drawback of first to fourth generation computers is that the computers have not 

their own thinking power. These are totally depending upon the instructions given by the 

users. 

Fifth generation computers are supposed to be the ideal computers, but do not exist. The 

scientists are working to design such computers that will have the following features. 

1. Having their own thinking power 

2. Making decisions themselves 

3. Having capabilities of learning 

4. Having capabilities of reasoning 

5. Having large capacity of internal storage 

6. Having extra high processing speed 

7. Having capabilities of parallel processing 

In these computers following technologies will be used: 

 ULSIC (Ultra Large Scale Integrated Circuits) technology 

 Artificial Intelligence (AI) technology also called the knowledge Processor. The AI 

means automatic programs that let the machines to think and decide themselves. The 

programming languages LISP (List Processor) and PROLOG (Programming with 

Logic) are used for artificial intelligence. The scientists at ICOT in Japan use the 

PROLOG to develop the Artificial Intelligence software. 

 

1.6  CLASSIFICATION OF COMPUTERS 

 Computers are classified according to their data processing speed, amount of data that 

they can hold and price. Generally, a computer with high processing speed and large internal 

storage is called a big computer. Due to rapidly improving technology, we are always 

confused among the categories of computers. 
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Depending upon their speed and memory size, computers are classified into following four 

main groups. 

1. Supercomputer. 

2. Mainframe computer. 

3. Mini computer. 

4. Microcomputer. 

 

1.6.1 Supercomputer 

Supercomputer is the most powerful and fastest, and also very expensive. It was developed in 

1980s. It is used to process large amount of data and to solve the complicated scientific 

problems. It can perform more than one trillions calculations per second. It has large number 

of processors connected parallel. So parallel processing is done in this computer. In a single 

supercomputer thousands of users can be connected at the same time and the supercomputer 

handles the work of each user separately. Supercomputers are mainly used for: 

 Weather forecasting. 

 Nuclear energy research. 

 Aircraft design. 

 Automotive design. 

 Online banking. 

 To control industrial units. 

The supercomputers are used in large organizations, research laboratories, aerospace centers, 

large industrial units etc. Nuclear scientists use supercomputers to create and analyze models 

of nuclear fission and fusions, predicting the actions and reactions of millions of atoms as 

they interact. The examples of supercomputers are CRAY-1, CRAY-2, Control Data CYBER 

205 and ETA A-10 etc. 

 

1.6.2 Mainframe Computers 

Mainframe computers are also large-scale computers but supercomputers are larger than 

mainframe. These are also very expensive. The mainframe computer specially requires a very 

large clean room with air-conditioner. This makes it very expensive to buy and operate. It can 

support a large number of various equipment. It also has multiple processors. Large 

mainframe systems can handle the input and output requirements of several thousands of 

users. For example, IBM, S/390 mainframe can support 50,000 users simultaneously. The 

users often access then mainframe with terminals or personal computers. There are basically 

two types of terminals used with mainframe systems. These are: 

i) Dumb Terminal 

Dumb terminal does not have its own CPU and storage devices. This type of terminal 

uses the CPU and storage devices of mainframe system. Typically, a dumb terminal 

consists of monitor and a keyboard (or mouse).  
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ii) Intelligent Terminal 

Intelligent terminal has its own processor and can perform some processing operations. 

Usually, this type of terminal does not have its own storage. Typically, personal 

computrers are used as intelligent terminals. A personal computer as an intelligent 

terminal gives facility to access data and other services from mainframe system. It also 

enables to store and process data locally. 

The mainframe computers are specially used as servers on the World Wide Web. The 

mainframe computers are used in large organizations such as Banks, Airlines and 

Universities etc. where many people (users) need frequent access to the same data, which is 

usually organized into one or more huge databases. IBM is the major manufacturer of 

mainframe computers. The examples of mainframes are IBM S/390, Control Data CYBER 

176 and Amdahl 580 etc. 

 

1.6.3 Minicomputers 

These are smaller in size, have lower processing speed and also have lower cost than 

mainframe. These computers are known as minicomputers because of their small size as 

compared to other computers at that time. The capabilities of a minicomputer are between 

mainframe and personal computer. These computers are also known as midrange computers. 

The minicomputers are used in business, education and many other government departments. 

Although some minicomputers are designed for a single user but most are designed to handle 

multiple terminals. Minicomputers are commonly used as servers in network environment 

and hundreds of personal computers can be connected to the network with a minicomputer 

acting as server like mainframes, minicomputers are used as web servers. Single user 

minicomputers are used for sophisticated design tasks. 

The first minicomputer was introduced in the mid-1960s by Digital Equipment Corporation 

(DEC). After this IBM Corporation (AS/400 computers) Data General Corporation and Prime 

Computer also designed the mini computers. 

 

1.6.4 Microcomputer 

The microcomputers are also known as Personal Computers or simply PCs. Microprocessor 

is used in this type of computer. These are very small in size and cost. The IBM’s first 

microcomputer was designed in 1981 and was named as IBM-PC. After this many computer 

hardware companies copied the design of IBM-PC. The term “PC-compatible” refers any 

personal computer based on the original IBM personal computer design. 

The most popular types of personal computers are the PC and the Apple. PC and PC-

compatible computers have processors with different architectures than processors in Apple 

computers. These two types of computers also use different operating systems. PC and PC-

compatible computers use the Windows operating system while Apple computers use the 

Macintosh operating system (MacOS). The majority of microcomputers sold today are part of 
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IBM-compatible. However the Apple computer is neither an IBM nor a compatible. It is 

another family of computers made by Apple computer. 

Personal computers are available in two models. These are: 

1. Desktop PCs 

2. Tower PCs 

A desktop personal computer is most popular model of personal computer. The system unit 

of the desktop personal computer can lie flat on the desk or table. In desktop personal 

computer, the monitor is usually placed on the system unit. 

Another model of the personal computer is known as tower personal computer. The system 

unit of the tower PC is vertically placed on the desk of table. Usually the system unit of the 

tower model is placed on the floor to make desk space free and user can place other devices 

such as printer, scanner etc. on the desktop. Today computer tables are available which are 

specially designed for this purpose. The tower models are mostly used at homes and offices. 

Microcomputers are further divided into following categories. 

1. Laptop computer 

2. Workstation 

3. Network computer 

4. Handheld computer 

 

Laptop computer 

Laptop computer is also known as notebook computer. It is small size (85-by-11 inch 

notebook computer and can fit inside a briefcase. The laptop computer is operated on a 

special battery and it does not have to be plugged in like desktop computer. The laptop 

computer is portable and fully functional microcomputer. It is mostly used during journey. It 

can be used on your lap in an airplane. It is because it is referred to as laptop computer. 

The memory and storage capacity of laptop computer is almost equivalent to the PC or 

desktop computer. It also has the hard dist, floppy disk drive, Zip disk drive, CD-ROM drive, 

CD-writer etc. it has built-in keyboard and built-in trackball as pointing device. Laptop 

computer is also available with the same processing speed as the most powerful personal 

computer. It means that laptop computer has same features as personal computer. Laptop 

computers are more expensive than desktop computers. Normally these computers are 

frequently used in business travelers. 

Workstations 

Workstations are special single user computers having the same features as personal 

computer but have the processing speed equivalent to minicomputer or mainframe computer. 

A workstation computer can be fitted on a desktop. Scientists, engineers, architects and 

graphic designers mostly use these computers. 
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Workstation computers are expensive and powerful computers. These have advanced 

processors, more RAM and storage capacity than personal computers. These are usually used 

as single-user applications but these are used as servers on computer network and web servers 

as well. 

 

Network computers  

Network computers are also version of personal computers having less processing power, 

memory and storage. These are specially designed as terminals for network environment. 

Some types of network computers have no storage. The network computers are designed for 

network, Internet or Intranet for data entry or to access data on the network. The network 

computers depend upon the network’s server for data storage and to use software. These 

computers also use the network’s server to perform some processing tasks. 

In the mid-1990s the concept of network computers became popular among some PC 

manufacturers. As a result several variations of the network computers quickly became 

available. In business, variations of the network computer are Windows terminals, NetPCs 

and diskless workstations. Some network computers are designed to access only the Internet 

or to an Intranet. These devices are sometimes called Internet PCs, Internet boxes etc. In 

home some network computers do not include monitor. These are connected to home 

television, which serves as the output devices. A popular example of a home-based network 

computer is Web TV, which enables the user to connect a television to the Internet. The Web 

TV has a special set-top box used to connect to the Internet and also provides a set of simple 

controls which enable the user to navigate the Internet, send and receive e-mails and to 

perform other tasks on the network while watching television. 

Network computers are cheaper to purchase and to maintain than personal computers. 

 

Handheld computer 

In the mid 1990s, many new types of small personal computing devices have been introduced 

and these are referred to as handheld computers. These computers are also referred to as 

Palmtop Computers. The handheld computers sometimes called Mini-Notebook Computers. 

The type of computer is named as handheld computer because it can fit in one hand while 

you can operate it with the other hand. Because of its reduced size, the screen of handheld 

computer is quite small. Similarly it also has small keyboard. The handheld computers are 

preferred by business traveler. Some handheld computers have a specialized keyboard. These 

computers are used by mobile employees, such as meter readers and parcel delivery people, 

whose jobs require them to move from place to place. 

The examples of handheld computers are: 

1. Personal Digital Assistance 

2. Cellular telephones 

3. H/PC Pro devices 

 



 
 
 

Information Technology                                   1.13                                        Introduction to Computers 

 

 
 

1. Personal Digital Assistance (PDAs) 

The PDA is one of the more popular lightweight mobile devices in use today. A PDA 

provides special functions such as taking notes, organizing telephone numbers and addresses. 

Most PDAs also offer a variety of other application software such as word processing, 

spreadsheet and games etc. Some PDAs include electronic books that enable users to read a 

book on the PDA’s screen. 

Many PDAs are web-based and users can send/receive e-mails and access the Internet. 

Similarly, some PDAs also provide telephone capabilities. 

The primary input device of a PDA is the stylus. A stylus is an electronic pen and looks like a 

small ballpoint pen. This input device is used to write notes and store in the PDA by touching 

the screen. Some PDAs also support voice input. 

2. Cellular phones 

A cellular phone is a web-based telephone having features of analog and digital devices. It is 

also referred to as Smart Phone. In addition to basic phone capabilities, a cellular phone also 

provides the functions to receive and send e-mails & faxes and to access the Internet. 

3. H/PC Pro Devices 

H/PC Pro dive is new development in handheld technology. These systems are larger than 

PDAs but they are not quite as large as typical notebook PCs. These devices have features 

between PDAs and notebook PCs. The H/PC Pro device includes a full-size keyboard but it 

does not include disk. These systems also have RAM with very low storage capacity and 

slow speed of processor. 

 

1.7  APPLICATIONS OF COMPUTERS 

 Education 

Nowadays educators are using techniques such as videos, pdfs, images and other 

animation software, so that the student can easily comprehend more complex and 

complex subjects with minimal effort to try and explain complex subjects in a more 

animated manner. 

 Technology 

Computer technology has gone to a different level. Every section of the society uses this 

modern machine to increase the productivity and quality of the products. Using computer 

technology farmers can predict the atmosphere and weather to exactly decide what should 

be next move. 
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 Business 

At present time we can manage our business almost from anywhere just using a 

computer, laptop or mobile phone with internet connection. According to a survey in 

2030, almost 95% of the business will use computers to help them in growing business 

and helping the service sector for improving their services. 

 

 Medical Fields 

In this Computer era, medical industry regulates their administrative as well as extra and 

better functionality of hospitals through Computers, which plays a vital role in the 

healthcare. 

 Government offices 

Almost every government offices use computers to reduce human load. Computers are 

used in a government office to send and receive mails for faster communications and to 

track the record of communications. In government office mainly work are done on 

spreadsheets, documents and text which this machine works in great speed. 

 Defense and Environment 

Super computers are used to track incoming missiles target to destroy them. They are 

used in tanks, planes and ship to target forces also for analysis and research. 

 Sports 

The introduction of the computers in sports and games is very great as the performance 

and the output of the result has been incredibly great. The chances of making the 

inaccurate or wrong decision are decreasing day by day. The computer can store data and 

analyze the history of games and specific players 

 Banking 

Every bank is computerized nowadays. Passbooks are updated using printers that are 

connected to a personal computer in a network that is centralized. ATM is another form 

of computer where we can withdraw as well as deposit cash. Online transactions has 

made possible because of these highly powerful and secured machines. 

 

1.8 SUMMARY 

A computing device, also referred as computer, processes the input data as per given 

instructions to generate desired output. This chapter provides information regarding 

computers generations. The characteristics of computer systems can be defined as the silent 

features they possess from time to time and uses of computers in day to day life. 
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1.9 TECHNICAL TERMS 

Computer, Computer Generations, Supercomputer, Mainframe computer, Minicomputer, 

Microcomputer, ENIAC, LSI, PDA 

 

 

1.10 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1. What is Computer? Discuss various applications of computers. 

2. Explain the generation of computers in detail. 

3. Explain classifications of computer. 

 Short Notes:   

1. Computer Definition 

2.   Characteristics of computers 

3. Limitations of computers 

 

1.11   SUGGESTED READINGS 

1. P.Mohan computer fundamentals- HimalayaPublications. 

2. R.K.Sharma and Shashi K Gupta, Computer Fundamentals - Kalyani Publications 

3. Fundamentals of Computers ByBalagurusamy, Mcgraw Hill 

4. Fundamentals of Computers Rajaraman V Adabala N 

 

AUTHOR: Prof. K. GANGADHARA RAO 

 



LESSON- 2 

HARDWARE 

AIMS AND OBJECTIVES 

In this unit the student can have overview of the basic design of a computer. He will 

understand how different parts of a computer are organized and how various operations are 

per­formed between different parts to do a specific task. The student can also understand the 

difference between input devices and output devices and their functionalities. 

 

STRUCTURE 

2.1 Introduction 

2.2 Basic organization of Computer 

2.3. Input Devices 

2.4 Output Devices 

2.5 Summary 

2.6 Technical Terms 

2.7 Self-Assessment Questions 

2.8  Suggested Readings 
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2.1  INTRODUCTION 

A computer can be defined as a fast electronic calculating machine that accepts. the (data) 

digitized input information process it as per the list of internally stored instructions and 

produces the resulting information. 

2.2 BASIC ORGANIZATION OF A COMPUTER 

The main component of basic organization of a computer system is microprocessor (C.P.U), 

memory unit (MU), and input-output devices. 

2.2.1 Functional Unit 

In order to carry out the operations mentioned in the previous section the computer allocates 

the task between its various functional units. The computer system is divided into three 

separate units for its operation. They are arithmetic logical unit, control unit, and central 

processing unit. 

 

2.2.2.1 Arithmetic Logic Unit (ALU) 

Most of the computer operators are executed in ALU of the processor like addition, 

subtraction, division, multiplication, etc. the operands are brought into the ALU from 

memory and stored in high speed storage elements called register. Then according to the 

instructions the operation is performed in the required sequence.  

The control and the ALU are many times faster than other devices connected to a computer 

system. This enables a single processor to control a number of external devices such as key 

boards, displays, magnetic and optical disks, sensors and other mechanical controllers. 

 

2.2.2.2 Control Unit (CU) 

The next component of computer is the Control Unit, which acts like the supervisor seeing 

that things are done in proper way. The control unit determines the sequence in which 

computer programs and instructions are executed. Things like processing of programs stored 
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in the main memory, interpretation of the instructions and issuing of signals for other units of 

the computer to execute them. It also acts as a switch board operator when several users 

access the computer simultaneously. Thereby it coordinates the activities of computer’s 

peripheral equipment as they perform the input and output. 

 

2.2.2.3 Central Processing Unit 

The ALU and the CU of a computer system is together known as the Central Processing Unit.  

CPU is also called as the brain of a computer system. It is just like brain that takes all major 

decisions, makes all sorts of calculations and directs different parts of the computer functions 

by activating and controlling the operations. 

The fundamental operation of most CPUs 

The program is represented by a series of bits (instructions) that are kept in some kind of 

computer memory. There are four steps that nearly all CPUs use in their operation: fetch, 

decode and execute 

 Fetch: 

o Retrieving an instruction from program memory. 

o The location in program memory is determined by a program counter (PC) 

o After an instruction is fetched, the PC is incremented by the length of the 

instruction word in terms of memory units. 

 

 Decode : 

o The instruction is broken up into parts that have significance to other portions of 

the CPU. 

o The way in which the numerical instruction value is interpreted is defined by the 

CPU's instruction set architecture (ISA). 

o Opcode, indicates which operation to perform. 

o The remaining parts of the number usually provide information required for that 

instruction, such as operands for an addition operation. 

o Such operands may be given as a constant value or as a place to locate a value: a 

register or a memory address, as determined by some addressing mode. 

 

 Execute : 

o During this step, various portions of the CPU are connected so they can perform 

the desired operation. 

o Suppose, if an addition operation was requested, an arithmetic logic unit (ALU) 

will be connected to a set of inputs and a set of outputs. 

o The inputs provide the numbers to be added, and the outputs will contain the final 

result. 

o If the addition operation produces a result too large for the CPU to handle, an 

arithmetic overflow flag in a flags register may also be set. 
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2.2.2.4 Memory 

It is function into store programs and data. It is basically to two types 

 Primary Memory: Is the one exclusively associated with the processor and operates at 

the electronics speeds programs must be stored in this memory while they are being 

executed. The memory contains a large number of semiconductors storage cells. Each 

cell is capable of storing one bit of information. These are processed in a group of 

fixed site called word. To provide easy access to a word in memory, a distinct address 

is associated with each word location. Addresses are numbers that identify memory 

location. Number of bits in each word is called word length of the computer. 

Programs must reside in the memory during execution. Instructions and data can be 

written into the memory or read out under the control of processor. Examples: RAM 

and ROM 

 Secondary Memory: Is used where large amounts of data & programs have to be 

stored, particularly information that is accessed infrequently. Examples: - Magnetic 

disks & tapes, optical disks (ie CD-ROM’s), floppies etc., 

 

2.2.2.5 Input Unit 

The source program or data is fed to a computer through input devices.  An input device 

sends information to a computer system for processing.  An input device can send data to 

another device, but it cannot receive data from another device.  

Examples: Keyboard, Mouse, Joystick, Digitizing Tablet, Touch Sensitive Screen, Light Pen, 

Space Mouse, Digital Stills Camera , Magnetic Ink Character (MICR) , Optical Mark Reader 

Recognition (OMR), Image Scanner, Bar Codes, Magnetic Reader , Smart Cards, Voice Data 

Entry, Sound Capture, Video Capture etc., 

 

2.2.2.6 Output Unit 

An output device reproduces or displays the results of that processing. Output devices display 

information in a way that you can you can understand. An output device can receive data 

from another device and generate output with that data, but it cannot send data to another 

device. Some devices can accept input and display output, and they are referred to as I/O 

devices (input/output devices). 

Examples:  

Printing :  Plotter, Printer 

Sound          :  Speakers 

Visual         :  Monitor 
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2.2.2 Basic Computer Operations 

A computer as shown in the below figure performs basically five major operations or 

functions irrespective of their size and make. These are 1) it accepts data or instructions by 

way of input, 2) it stores data, 3) it can process data as required by the user, 4) it gives results 

in the form of output, and 5) it controls all operations inside a computer. We discuss below 

each of these operations. 

 

 

 

 Input: This is the process of entering data and programs in to the computer system. We 

should know that computer is an electronic machine like any other machine, which takes 

as inputs raw data and performs some processing giving out rocessed data. Therefore, the 

input unit takes data from us to the computer in an organized manner for processing. 

 

 Storage: The process of saving data and instructions permanently is known as storage. 

Data has to be fed into the system before the actual processing starts. It is because the 

processing speed of Central Processing Unit (CPU) is so fast that the data has to be 

provided to CPU with the same speed. Therefore the data is first stored in the storage unit 

for faster access and processing. This storage unit or the primary storage of the computer 

system is designed to do the above functionality. It provides space for storing data and 

instructions. 

The storage unit performs the following major functions: 

o All data and instructions are stored here before and after processing 

o Intermediate results of processing are also stored here. 

 

 Processing: The task of performing operations like arithmetic and logical operations is 

called processing. The Central Processing Unit (CPU) takes data and instructions from 

the storage unit and makes all sorts of calculations based on the instructions given and the 

type of data provided. It is then sent back to the storage unit. 
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 Output: This is the process of producing results from the data for getting useful 

information. Similarly the output produced by the computer after processing must also be 

kept somewhere inside the computer before being given to you in human readable form. 

Again the output is also stored inside the computer for further processing. 

 

 Control: The manner how instructions are executed and the above operations are 

performed. Controlling of all operations like input, processing and output are performed 

by control unit. It takes care of step-by-step processing of all operations inside the 

computer. 

 

2.3 INPUT DEVICES 

 

Keyboard: 

The Keyboard is the standard data input and operator control device for a computer. It 

consists of the standard QWERTY layout with a numeric keypad and additional function 

keys for control purposes. 

  

Mouse: 

The Mouse is a popular input device. You move it across the desk and its movement is shown 

on the screen by a marker known as a 'cursor'. You will need to click the buttons at the top of 

the mouse to select an option. 

  

Track Ball: 

Track ball looks like a mouse, as the roller is on the top with selection buttons on the side. It 

is also a pointing device used to move the cursor and works like a mouse. For moving the 

cursor in a particular direction, the user spins the ball in that direction. It is sometimes 

considered better than a mouse, because it requires little arm movement and less desktop 

space. It is generally used with Portable computers. 

 

MICR: 

Magnetic Ink Character Recognition (MICR) is used to recognize the magnetically 

charged characters, mainly found on bank cheques. The magnetically charged characters are 

written by special ink called magnetic ink. MICR device reads the patterns of these characters 

and compares them with special patterns stored in memory. Using MICR device, a large 

volume of cheques can be processed in a day. MICR is widely used by the banking industry 

for the processing of cheques. 
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 JoyStick: 

The joystick is a rotary lever. Similar to an aircraft's control stick, it enables you to 

move within the screen's environment, and is widely used in the computer games industry. 

 

Digitizing Tablet:  

A Digitizing Tablet is a pointing device that facilitates the accurate input of drawings and 

designs. A drawing can be placed directly on the tablet, and the user traces outlines or inputs 

coordinate positions with a hand-held stylus. 

  

Touch Screen: 

A Touch Sensitive Screen is a pointing device that enables the user to interact with the 

computer by touching the screen. There are three types of Touch Screens: pressure-sensitive, 

capacitive surface and light beam. 

  

Light Pen: 

A Light Pen is a pointing device shaped like a pen and is connected to a VDU. The tip of the 

light pen contains a light-sensitive element which, when placed against the screen, detects the 

light from the screen enabling the computer to identify the location of the pen on the screen. 

Light pens have the advantage of 'drawing' directly onto the screen, but this can become 

uncomfortable, and they are not as accurate as digitising tablets. 
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 OMR: 

The Optical Mark Reader (OMR) can read information in the form of numbers or letters and 

put it into the computer. The marks have to be precisely located as in multiple choice test 

papers. 

  

Scanners 

Scanners allow information such as a photo or text to be input into a computer. Scanners 

are usually either A4 size (flatbed), or hand-held to scan a much smaller area. If text is to be 

scanned, you would use an Optical Character Recognition (OCR) program to recognise the 

printed text and then convert it to a digital text file that can be accessed using a computer. 

  

Bar Code: 

A Bar Code is a pattern printed in lines of differing thickness. The system gives fast and 

error-free entry of information into the computer. You might have seen bar codes on goods in 

supermarkets, in libraries and on magazines. Bar codes provide a quick method of recording 

the sale of items. 

  

Card Reader: 

This input device reads a magnetic strip on a card. Handy for security reasons, it provides 

quick identification of the card's owner. This method is used to run bank cash points or to 

provide quick identification of people entering buildings. 

 

Smart Card: 

Smart Card: This input device stores data in a microprocessor embedded in the card. This 

allows information, which can be updated, to be stored on the card. This method is used in 

store cards which accumulate points for the purchaser, and to store phone numbers for 

cellular phones. 

 

2.4  OUTPUT DEVICES 

 

Output devices are pieces of equipment that are used to get information or any other response 

out from computer. These devices display information that has been held or generated within 

a computer. Output devices display information in a way that you can understand. The most 

common output device is a monitor. 
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2.4.1 Printers: 

Printer is an output device, which is used to print information on paper. 

There are two types of printers − 

 Impact Printers 

Impact printers print the characters by striking them on the ribbon, which is then pressed 

on the paper. These printers are two types 

Character printers 

 Character printers are the printers which print one character at a time. These are 

further divided into two types: Dot Matrix Printer (DMP), Daiy Wheel, and Dot Matrix 

Printer 

Line Printers 

 Line printers are the printers which print one line at a time. These are of two types: 

Drum Printer, Chain Printer, and Drum Printer 

 Non-impact Printers 

Non-impact printers print the characters without using the ribbon. These printers print 

a complete page at a time, thus they are also called as Page Printers. These printers are 

of two types Laser Printers and Inkjet Printers 

Characteristics of Non-impact Printers 

 Faster than impact printers 

 They are not noisy 

 High quality 

 Supports many fonts and different character size 

 

2.4.2 Plotter 

 

Plotter is a computer hardware device much like a printer that is used for printing vector 

graphics. Instead of toner, plotters use a pen, pencil, marker, or another writing tool to draw 

multiple, continuous lines onto paper rather than a series of dots like a traditional printer. 

 

Plotters are specialized pieces of equipment designed to print out vector graphics in a variety 

of colors. Three types of plotters are most popular for their ability to allow you to create 

different designs. 
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Drum plotter: print graphics of any width and length adds great versatility in printing 

a wide variety of large documents. Some of the documents created include 

architectural drawings. 

Flatbed plotter: useful for printing larger architectural or CAD drawings. 

Inkjet plotters: Because of these affordable and versatile, they have many advantages 

in real time environment. 

 

2.4.3  Speakers  

Speakers are output devices that allow you to hear sound from your computer. 

Computer speakers are just like stereo speakers.  

 

2.4.4 Projector 

A projector is an output device that enables the user to project the output onto a large surface 

such as a big screen or wall. It can be connected to a computer and similar devices to project 

their output onto a screen. It uses light and lenses to produce magnified texts, images, and 

videos. So, it is an ideal output device to give presentations or to teach a large number of 

people. 

Modern projects (digital projectors) come with multiple input sources such as HDMI ports 

for newer equipment and VGA ports that support older devices. Some projectors are designed 

to support Wi-Fi and Bluetooth as well. They can be fixed onto the ceiling, placed on a stand, 
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and more and are frequently used for classroom teaching, giving presentations, home 

cinemas, etc. 

A digital projector can be of two types: 

Liquid Crystal Display (LCD) digital projector 

Digital Light Processing (DLP) digital projector 

 

 

Monitors: 

Monitors are also called as Visual Display Unit (VDU), are the main output device of a 

computer. It forms images from tiny dots, called pixels that are arranged in a rectangular 

form. The sharpness of the image depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

The CRT display is made up of small picture elements called pixels. The smaller the 

pixels, the better the image clarity or resolution. It takes more than one illuminated 

pixel to form a whole character 

 Flat-Panel Display 

 The flat-panel display refers to a class of video devices that have reduced volume, 

weight and power requirement in comparison to the CRT. You can hang them on 

walls or wear them on your wrists. Current uses of flat-panel displays include 

calculators, video games, monitors, laptop computer, and graphics display. 

 

2.5 SUMMARY 

Computer hardware (usually simply called hardware when a computing context is 

concerned) is the collection of physical elements that constitutes a computer system. 

Computer hardware is the physical parts or components of a computer, such as the monitor, 

mouse, keyboard, computer data storage, hard disk drive (HDD), graphic cards, sound cards, 

memory, motherboard, and so on, all of which are physical objects that are tangible. In 

contrast, software is instructions that can be stored and run by hardware.  
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2.6 TECHNICAL TERMS 

CPU, ALU, Memory, RAM, ROM, Instruction Cycle, Input Devices, Output Devices. 

 

2.7 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1. What are the five basic operations performed by the computer? 

2. Explain various input devices 

3. Explain various output devices. 

4. Explain basic organization of a Computer. 

       Short Notes:   

1. Define ALU, CU and CPU. 

2. What are functional units of basic computer system? 

3. Write short notes on any two input and output devices. 

 

 

    

2.8   SUGGESTED READINGS 

 

1. P.Mohan computer fundamentals- HimalayaPublications. 

2. R.K.Sharma and Shashi K Gupta, Computer Fundamentals - Kalyani Publications 

3. Fundamentals of Computers ByBalagurusamy, Mcgraw Hill 

4. Fundamentals of Computers Rajaraman V Adabala N 
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LESSON- 3 

COMPUTER MEMORY 

AIMS AND OBJECTIVES 

In this unit the student will learn Characteristics required for a device to be used as a cell 

in a computer's memory. How memory cells are arranged to create different types of 

memories. How the main memory of the computer is maintained. He also learns about cache 

memory. 

 

STRUCTURE 

3.1 Introduction 

3.2 Basics of Computer Memory 

 3.2.1 Measurement of Memory 

 3.2.2 Memory Hierarchy 

3.3. Primary Memory 

3.4 Secondary Memory 

3.5 Cache Memory 

3.6 Summary 

3.7 Technical Terms 

3.8 Self-Assessment Questions 

3.9  Suggested Readings 
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3.1  INTRODUCTION 

Computer memory consists of number of storage locations, or cells, each of which has a 

unique numeric address. Addresses are usually written in hexadecimal. Each storage location 

can contain a fixed number of binary digits. The most common size is one byte. Most 

computers group bytes together into words.  

Memory Unit is that component of a computer system, which is used to store the data, 

instructions and information before, during and after the processing by ALU. It is actually a 

work area (physically a collection of integrated circuits) within the computer, where the CPU 

stores the data and instructions. It is also known as a Main Memory or Primary Memory. 

 

3.2 BASICS OF COMPUTER MEMORY 

Both programs and data are stored in binary form in computer's memory. The binary system 

has only two digits, 0 and 1. These are called bits. A bit stands for binary digit, which stands 

for one binary piece of information. 

 Humans can understand the decimal system but the computer can understand only the binary 

system. The computer takes input in the form of 0 and 1 and gives output in the same form, 

i.e., 0 and 1 only. But we do not receive output in the form of 0’s & 1’s only. This is because 

every number stored in binary form can be converted to decimal system and vice versa.  

For example, 1010 in binary is equivalent to 10 in decimal. Therefore, it is the computer that 

takes information or data in decimal form from user, converts it into binary form, processes 

it; produces output in binary form and finally again converts the output to decimal form. 

 

3.2.1 Measurement of Memory 

The primary or internal storage unit is made up of several small storage locations called cells. 

Each of these cells can store a fixed number of bits called word length. Each cell has a unique 

number assigned to it called the address of the cell and it is used to identify the cells. So we 

can say that memory is like a large cabinet that has as many drawers as there are addresses in 

memory. Each drawer has a word and the address is written on the outside of the drawer.  

We know that data in computer is stored in the form of 0s and 1s. Each of these digits is 

known as a bit. A collection of 8 bits constitutes a byte. Each cell of memory contains one 

character or 1 byte of data. So the capacity is defined in terms of bytes or words. However 

higher units of memory are Kilobytes, Megabytes, Gigabytes etc. 
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Name Equal To Size(In Bytes) 

Bit 1 Bit 1/8 

Nibble 4 Bits 1/2 (rare) 

Byte 8 Bits 1 

Kilobyte 1024 Bytes 1024 

Megabyte 1, 024 Kilobytes 1, 048, 576 

Gigabyte 1, 024 Megabytes 1, 073, 741, 824 

Terrabyte 1, 024 Gigabytes 1, 099, 511, 627, 776 

Petabyte 1, 024 Terabytes 1, 125, 899, 906, 842, 624 

Exabyte 1, 024 Petabytes 1, 152, 921, 504, 606, 846, 976 

Zettabyte 1, 024 Exabytes 1, 180, 591, 620, 717, 411, 303, 424 

Yottabyte 1, 024 Zettabytes 1, 208, 925, 819, 614, 629, 174, 706, 176 

 

3.2.2 Memory Hierarchy 

In the Computer System Design, Memory Hierarchy is an enhancement to organize the 

memory such that it can minimize the access time. The Memory Hierarchy was developed 

based on a program behavior known as locality of references. 
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This Memory Hierarchy Design is divided into 2 main types: 

 External Memory or Secondary Memory –Comprising of Magnetic Disk, Optical 

Disk, Magnetic Tape i.e. peripheral storage devices which are accessible by the 

processor via I/O Module. 

 Internal Memory or Primary Memory –Comprising of Main Memory, Cache Memory 

& CPU registers. This is directly accessible by the processor. 

We can infer the following characteristics of Memory Hierarchy Design from above figure: 

 Capacity: 

It is the global volume of information the memory can store. As we move from top to bottom 

in the Hierarchy, the capacity increases. 

 Access Time: 

It is the time interval between the read/write request and the availability of the data. As we 

move from top to bottom in the Hierarchy, the access time increases. 

 Performance: 

Earlier when the computer system was designed without Memory Hierarchy design, the 

speed gap increases between the CPU registers and Main Memory due to large difference in 

access time. This results in lower performance of the system and thus, enhancement was 

required.  

This enhancement was made in the form of Memory Hierarchy Design because of which the 

performance of the system increases. One of the most significant ways to increase system 

performance is minimizing how far down the memory hierarchy one has to go to manipulate 

data. 

 



 
 
 

Information Technology                                 3.5                                                    Computer Memory 

 

 
 

 Cost per bit 

As we move from bottom to top in the Hierarchy, the cost per bit increases i.e. Internal 

Memory is costlier than External Memory. 

 

3.3 PRIMARY MEMORY 

Primary memory is the memory that is accessed by the processor directly. It is also known as 

main memory or internal memory. It helps in executing applications that are temporarily 

stored in a specific memory location. Primary memory is of two types – RAM and ROM. 

 

3.3.1 Random Access Memory (RAM) 

Random Access Memory (RAM) is the type of memory in which it is possible to randomly 

select and use any location of the memory directly to store and retrieve data. It is also called 

as read/write memory. Since it is volatile, the data from RAM is lost as soon as the power to 

the computer is switched off. 

 

Two main types of RAM are: 

 Static RAM 

Static RAM is the full form of SRAM. In this type of RAM, data is stored using the state of a 

six transistor memory cell. Static RAM is mostly used as a cache memory for the processor 

(CPU). 
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 Dynamic RAM 

DRAM stands for Dynamic Random Access Memory. It is a type of RAM which allows you 

to stores each bit of data in a separate capacitor within a specific integrated circuit. Dynamic 

RAM is a standard computer memory of the many modern desktop computers. 

This type of RAM is a volatile memory that needs to be refreshed with voltage regularly. Else 

it loses the information stored on it. 

 

3.3.2 Read Only Memory (ROM) 

This is another type of primary memory from which data can only be read. We cannot write 

or modify data once written on to the ROM. Also this type of primary memory is not volatile. 

The storage of program and data in the ROM is permanent. 

The ROM stores some standard processing programs supplied by the manufacturers to 

operate our computer. The Basic Input Output System (BIOS) is stored in the ROM. It 

examines and initializes the startup process of the computer and also checks various 

peripheral devices attached to the PC when the computer is turned ON.  

The various types of ROMs are discussed below: 

 Programmable Read Only Memory (PROM): You know that it is not possible to modify 

or erase programs stored in ROM, but it is possible for you to store your program in 

PROM chip. Once the programs are written it cannot be changed. Also the program is not 

lost even if power is switched off. 
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 Erasable Programmable Read Only Memory (EPROM): This type of ROM overcomes 

the problem of PROM and ROM. EPROM chip can be programmed time and again by 

erasing the information stored earlier in it. Information stored in EPROM can be erased 

by exposing it to ultraviolet light. This memory can be reprogrammed using a special 

programming facility. When the EPROM is in use, information can only be read. 

 

 
 

 Electrically Erasable Programmable Read Only Memory (EEPROM): This type of ROM 

is somewhat similar to EPROM. The only difference is that unlike EPROM, electrical 

signals are used to erase the contents of EEPROM. Also, this type of ROM need not be 

completely erased. Partial modification of ROM is possible. 

 

 

 

3.4 SECONDARY MEMORY 

The need for secondary storage 

Computers use main memory such as random access memory (RAM) and cache to hold data 

that is being processed. Secondary storage memory is volatile - it loses its contents when the 

computer is switched off. Secondary storage is non-volatile, long-term storage. Without 

secondary storage all programs and data would be lost the moment the computer is switched 

off. 

There are three main types of secondary storage in a computer system: 
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 solid state storage devices 

 optical storage devices 

 magnetic storage devices 

 

3.4.1 Solid state storage Devices: 

Solid state storage is a special type of storage made from silicon microchips. It can be written 

to and overwritten like RAM. However, unlike RAM, it is non-volatile, which means that 

when the computer's power is switched off, solid state storage will retain its contents. 

 

Solid state is also used as external secondary storage, for example on USB memory sticks and 

solid state drives. One of the main advantages of solid state storage is that there are no 

moving parts. For this reason, it is more portable and produces less heat compared to 

traditional magnetic storage devices. Less heat means the components last longer. And solid 

storage device is more portable and durable. 

Solid state storage is also faster than traditional hard disk drives because the data is stored as 

electrically in silicon chips called cells. In cells, binary data is stored by capturing electrical 

current in a transistor with on / off mode. Unlike RAM, which uses a similar technology, it 

has solid state storage even when power is turned off using a technology called flash 

memory. 

Solid state is a storage medium suitable for many modern devices such as tablets, 

smartphones and digital cameras. 

 

 

3.4.2 Magnetic devices 

Magnetic devices, such as hard disk drives, use magnetic fields to magnetize small individual 

sections of a metal spinning disc. Each small section represents a bit. The magnetized section 

represents binary '1' and the demagnetized section represents binary '0'. These partitions are 

so small that disks can contain terabytes (TB) of data. 

As the disk rotates, a read / write head moves across its surface. To write data, the head 

magnetizes or demagnetizes a section of disk that rotates beneath it. To read the data, the 

head makes a note of whether the section is magnetized or not. 
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Magnetic devices are very cheap in cost, high efficiency and durable. However, they are 

more likely to be damaged if dropped. They can also damage magnetic fields - erasing the 

data that a strong magnetic device holds. 

 

 

3.4.3 Optical devices 

Optical devices use a laser to scan the surface of a spinning disc made of metal and plastic. 

The disk surface is divided into tracks, each track having several flat areas and hollows. Flat 

areas are called lands and hollows are called as pits. 

When the laser shines on the disc surface, lands reflect the light back, whereas pits scatter the 

laser beam. A sensor looks for the reflected light. Reflected light - land - represents a binary 

'1', and no reflection - pits - represents a binary '0'. 

When the laser flashes on the disk surface, the surface of disk reflects the light back, while 

the pits scatter the laser beam. The sensor looks for reflected light. Reflected light surface 

denotes binary '1' and no reflection that is pits denote binary '0'. 
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3.5 CACHE MEMORY 

A Cache (Pronounced as “cash”) is a small and very fast temporary storage memory. It is 

designed to speed up the transfer of data and instructions. It is located inside or close to the 

CPU chip. It is faster than RAM and the data/instructions that are most recently or most 

frequently used by CPU are stored in cache. 

The data and instructions are retrieved from RAM when CPU uses them for the first time. A 

copy of that data or instructions is stored in cache. The next time the CPU needs that data or 

instructions, it first looks in cache. If the required data is found there, it is retrieved from 

cache memory instead of main memory. It speeds up the working of CPU. 

Levels of Cache Memory: 

A computer can have several different levels of cache memory. The level numbers refers to 

distance from CPU where Level 1 is the closest. All levels of cache memory are faster than 

RAM. The cache closest to CPU is always faster but generally costs more and stores less data 

then other level of cache. 

 

The following are the deferent levels of Cache Memory. 

 

Level 0 (L0) Cache 

It has have been proposed in the past as an inexpensive way to improve performance and 

reduce energy consumption in resource-constrained embedded processors. 

 

Level 1 (L1) Cache 

It is also called primary or internal cache. It is built directly into the processor chip. It has 

small capacity from 8 Km to 128 Kb. 

 

Level 2 (L2) Cache 

It is slower than L1 cache. Its storage capacity is more, i-e. From 64 Kb to 16 MB. The 

current processors contain advanced transfer cache on processor chip that is a type of L2 

cache. The common size of this cache is from 512 kb to 8 Mb. 

 

Level 3 (L3) Cache 

This cache is separate from processor chip on the motherboard. It exists on the computer that 

uses L2 advanced transfer cache. It is slower than L1 and L2 cache. The personal computer 

often has up to 8 MB of L3 cache 

 

3.6 SUMMARY 

Computer memory is the storage space in the computer, where data is to be processed 

and instructions required for processing are stored. The memory is divided into large number 

of small parts called cells. The chapter has introduced the concept of memory units and its 

categories as the main and the second memory and their characteristic features. It discusses 

the features of RAM, ROM, PROM, and EPROM and Cache Memory. 
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3.7 TECHNICAL TERMS 

Memory, Memory Hierarchy, RAM, ROM, Cache Memory, Primary Memory, 

Secondary Memory. 

 

3.8 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1. Differentiate RAM and ROM 

2. Describe how the data is read from a Hard Disk 

3. Write any four examples of optical storage media.. 

 

 Short Notes:   

1. Explain what is meant by primary and secondary storage. 

2. Memory Hierarchy 

3. Cache Memory 

 

    

3.9   SUGGESTED READINGS 

 

1. P.Mohan computer fundamentals- HimalayaPublications. 

2. R.K.Sharma and Shashi K Gupta, Computer Fundamentals - Kalyani Publications 

3. Fundamentals of Computers ByBalagurusamy, Mcgraw Hill 

4. Fundamentals of Computers Rajaraman V Adabala N 
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LESSON- 4 

SOFTWARE 

AIMS AND OBJECTIVES 

Upon successful completion of this chapter, student will be able to: 

 Define the term software; 

 Describe the two primary categories of software; 

 Understand how system software interacts with application software 

 What are various types of software used in our daily life? 

 

STRUCTURE 

4.1 Introduction 

4.2 Types of Software 

4.3. System Software 

4.4 Application Software 

4.5 Commercial software 

4.6 Open Source Software 

4.7 Domain software 

4.8 Free ware software 

4.9 Summary 

4.10 Technical Terms 

4.11 Self-Assessment Questions 

4.12 Suggested Readings 

  



Centre for Distance Education                               4.2                           Acharya Nagarjuna University  

 

4.1  INTRODUCTION 

The organization of the computer is defined by its internal registers, the timing and control 

structure, and the set of instructions that it uses. Internal organization of a computer is 

defined by the sequence of micro-operations it performs on data stored in its registers. 

Computer can be instructed about the specific sequence of operations it must perform.  

User controls this process by means of a Program. Program is a set of instructions that 

specify the operations, operands, and the sequence by which processing has to occur. 

Instruction is a binary code that specifies a sequence of micro-operations for the computer. 

The computer reads each instruction from memory and places it in a control register. The 

control then interprets the binary code of the instruction and proceeds to execute it by issuing 

a sequence of micro-operations is called Instruction Cycle 

4.1.1 Software 

Software is a collection of computer programs and related data that provides the instructions 

for telling a computer what to do and how to do it and also we can say that software is any set 

of instructions that guides the hardware and tells it how to accomplish each task. 

Without software, there is no use of hardware. It cannot produce any output on its own. 

Software is a general term used to describe a collection of computer system programs, 

procedures and documentation that perform some task on a computer system. Usually written 

in high level programming languages software are easier and more efficient for users to use 

than machine language. 

 

High level languages are compiled or defined into machine language object code. Software 

engineers develop and maintain software. With technological changes, software changes 

happen faster than hardware changes. 

4.1.2 Characteristics of Good Software 

 Provides the required functionality. 

 It is usable even by the inexperienced users. 

 Reliable and dependable. 

 It functions efficiently. 

 It has a life span at least measured in years. 
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 provides an appropriate user interface 

 It is  accompanied by complete documentation 

 It can be maintained easily. 

4.1.3 Functions of Software 

 It manages the computer resources of organizations. 

 It provides tools for people to make use of these resources. 

 It acts as an intermediary between companies and stored data and information. 

 

4.2 TYPES OF SOFTWARE 

Computer software is mainly based on purpose the software serves.  

This can be broadly classified into two categories i.e. Systems and Application software  
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4.3 SYSTEM SOFTWARE 

System software is computer software designed to operate the computer hardware to provide 

basic functionality and to provide a platform for running application software. It also refers to 

the operating system and all utility programs that manage computer resources at a low level.  

The BIOS (basic input/output system) gets the computer system started after you turn it on 

and manages the data flow between the operating system and attached devices such as the 

hard disk, video adapter, keyboard, mouse, and printer. 

The boot program loads the operating system into the computer's main memory or random 

access memory (RAM). 

There are various categories of systems software. Some of them are 

 Operating system 

 Utility programs 

 Language Translators 

 System library files. 

 

4.3.1 Operating Systems 

An operating system is act as an intermediary between the user of a computer and computer 

hardware. The purpose of an operating system is to provide an environment in which a user 

can execute programs in a convenient and efficient manner. 

An operating system is software that manages the computer hardware. The hardware must 

provide appropriate mechanisms to ensure the correct operation of the computer system and 

to prevent user programs from interfering with the proper operation of the system. 

The operating system so much relies on the device driver to communicate with each hardware 

device. A device driver is a small program that tells the OS how to communicate with the 

device. 

 

4.3.2 Utility Programs 

Utility programs are special programs are used to enhance performance of the computer 

system. They help to manage, maintain and control computer resources. These programs 

include: File viewers, File compression utility, backup utilities, antivirus, screen savers, etc 

Various tasks of utility programs are scan and fix computer viruses, Help in file backup, 

Compress files of disks, Partition disks into individual logical drives., Perform tasks on files 

(move files, delete files, etc) and Diagnose computer problems. 

Personal computers come loaded with utility programs designed to help resolve issues and 

maintain optimum performance. These utilities are easily accessed through Advanced 

Settings in our computer system. 
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4.3.3. Language Translators 

A translator is a programming language processor that converts a computer program from 

one language to another.  It takes a program written in source code and converts it into 

machine code.  It discovers and identifies the error during translation. 

It translates high-level language program into a machine language program that the central 

processing unit (CPU) can understand.  It also detects errors in the program. 

There are 3 different types of translators. They are compilers, interpreters and assemblers 

Compilers convert high-level language code to machine (object) code at a time and then save 

the executable object code to memory. A compiler creates machine code that runs on a 

processor with a specific Instruction Set Architecture (ISA), which is processor-dependent. 

Examples: Microsoft Visual Studio, GNU Compiler Collection (GCC), Common 

Business Oriented Language (COBOL) 

 

Interpreter is a translator used to convert high-level programming language to low-level 

programming language.  It converts the program one at a time and reports errors detected at 

once, while doing the conversion.  With this, it is easier to detect errors than in a compiler.  

An interpreter is faster than a compiler as it immediately executes the code upon reading the 

code. 

Examples: LISP, Python 

 

An Assembler is a translator used to translate assembly language to machine language.  

Assembly language is difficult to understand as it is a low-level programming language.  An 

assembler translates a low-level language, an assembly language to an even lower-level 

language, which is the machine code. 

Examples: FORTRAN Assembly Program (FAP), Macro Assembly Program (MAP), 

Symbolic Optimal Assembly Program (SOAP). 

 

4.3.4 System Library files 

A library file is the actual executable code that does the work as specified in that header file. 

This is linked in by the linker to provide the actual functionality. Libraries are particularly 

useful for storing frequently used routines because we do not need to explicitly link them to 

every program that uses them. The linker automatically looks in libraries for routines that it 

does not find elsewhere.  some library files extensions are .lib, .dll etc., 
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4.4 APPLICATION SOFTWARE 

Application software is a program that designed to meet user specific needs. The primary 

function of application software is to apply the computer to users solve problems and 

accomplish specific tasks. Application software, such as word processing, spreadsheets, e-

mail, database, and Web browser, can help us perform tasks such as creating documents, 

analyzing finances, sending messages, organizing data, and viewing pages on the Internet 

respectively. 

 

Application software can be classified into two types. They are Off- the shelf software and 

Customized or Bespoke software. 

 Off- the shelf software:  This is software designed and packaged for sale. A user will 

find it readily available in shops for sale. Off-the -shelf is further subdivided into two 

types. General purpose software and Special purpose software. 

 

o General purpose application software is a type of software that can be used 

for a variety of tasks. It is not limited to one particular function. For example a 

word processor could be classed as general purpose software as it would allow 

a user to write a novel, create a restaurant menu or even make a poster 

 

o Special purpose application software is a type of software created to execute 

one specific task. For example a camera application on your phone will only 

allow you to take and share pictures. Another example would be a chess game, 

it would only allow you to play chess, web browsers, calculators, media 

players, calendar programs etc. 

 

 Bespoke/Customized Application Software: Bespoke application software is tailor 

made for a specific user and purpose. For example a factory may require software to 

run a robot to make cars, however, it is the only factory making that car in the world, 

so the software required would have to be specially build for the task. Other examples 

might include software for hospitals and medical equipment, software being written 

inside banks and other financial institutions. 

 

Examples for application software are: 

 MS Word, WordPad and Notepad 

 Internet browsers like Firefox, Safari, and Chrome 

 Microsoft Power Point, Keynotes 

 Auto CAD 

 MySQL, Oracle, MS Access 

 Apple Numbers, Microsoft Excel 

 Real Player, Media Player 

 Dictionaries: Encarta, Britannica 

 Mathematical: MATLAB 

 Others: Google Earth, NASA World Wind 

 OpenOffice, Microsoft Office 
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4.5 COMMERCIAL SOFTWARE 

Refers to software that requires payment before it can be used. Commercial software 

programs typically come in a physical box, which is what you see displayed in retail stores, 

while others are available as downloads over the Internet. 

Packaged software is an example of commercial software, which is copyrighted and designed 

to meet the needs of a wide variety of users. Software copyright is a law used by proprietary 

(commercial) software companies to prevent the unauthorized copying of their software. 

Microsoft products such as the Windows Operating System and MS Office are some of the 

most well-known examples of commercial software. 

The benefits of commercial software include support guarantee, timely updates, and patches. 

While being free and customizable, open-source business software comes with hidden costs 

relating to maintenance, training staff, and security risks 

Examples for Commercial Software are:  

 A POS system (Point Of Sale) 

 Inventory Systems 

 Scheduling & Calendar Software 

 Fleet Management Software 

 Mapping or GIS Software 

 Analytics software for specific industries 

 A financial system used for accounting and finance 

 A CRM System to manage customers 

 An HR System used by Human Resources to Manage Personnel 

 Charting or Visualization Software 

 

4.6 OPEN SOURCE SOFTWARE 

Open source software is Software provided for use, modification and redistribution. It is a 

software that any programmer can download from the Internet for free and modify with 

suggested improvements. The only qualification is that changes can't be copyrighted. It is so 

popular because any programmer can make improvements which can result in better quality 

software. 

Examples: 

 Firefox—a Web browser that competes with Internet Explorer 

 OpenOffice—a competitor to Microsoft Office 

 Gimp—a graphic tool with features found in Photoshop 

 Marketcetera—an enterprise trading platform for hedge fund managers that competes 

with FlexTrade and Portware 
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 Zimbra—open source e-mail software that competes with Outlook server 

 MySQL, Ingres, and EnterpriseDB—open source database software packages that 

each go head-to-head with commercial products from Oracle, Microsoft, Sybase, and 

IBM 

 SugarCRM—customer relationship management software that competes with 

Salesforce.com and Siebel 

 Free BSD and Sun’s OpenSolaris—open source versions of the Unix operating 

system 

Advantages: 

 The source codes are available to users and they have the rights to modify them. This 

will allow improvements to the software without having to invest large sum of money 

in research and development. 

 The modified and improved source codes can be freely redistributed. 

 The open source software is created according to industry demands but allows for 

upgrades to take place freely when the need arises.Therefore, if bugs in the codes are 

found, they can be fixed by anyone interested and capable. 

 The software can be used in any way and for any legal purposes. There is no 

restriction in a unilateral way on how the software could be used. 

Disadvantages 

 The codes are too complicated for beginner to understand. 

 There is no particular official monitoring the works of a programmer improving the 

codes. This is because anyone is free to use, modify or even distribute the codes. 

 Since nobody in particular is responsible for the codes, there is no exact knowledge 

and assurance on when the codes are going to be fixed if there a bugs in it. Thus, users 

will have to use the problematic software until someone rectifies the problem 

 

4.7 DOMAIN SOFTWARE 

One of the prerequisites for the development of a software system is that we have a definition 

and a clear understanding of the contents of the application domain concerned. This is the 

part of an organization for which we are to develop application software. This means that the 

application domain is our starting point and the context for our software development. 

An application domain is the segment of reality for which a software system is developed. It 

is the background or starting point for the actual-state analysis and the creation of a domain 

model. 

An application domain can be an organization, a department within an organization, or a 

single workplace. 

Domain is a subject area in which our project belongs to. It may be banking, finance, sales, 

health, media, telecom, Insurance, Medical, Advertising, Travel, etc. 
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Different Domains in Software Development is - 

 Web development 

 Scientific development 

 Business development 

 Medical devices 

 Industrial and process control 

 Embedded systems 

 Big Data 

 Defense systems 

 Systems software (Operating Systems & such) 

 Tools (Assemblers, Compilers, Linkers, etc.) 

 

4.8 FREEWARE SOFTWARE 

Freeware is a combination of the words free and software, to mean “free software.” But it is 

not exactly the same as “free software.” 

Freeware means there are no paid licenses required to use the application, no fees or 

donations necessary, no restrictions on how many times you can download or open the 

program, and no expiration date. 

However, it can still be restrictive in some ways. Freeware is cost-free software In other 

words, freeware is software under copyright but available at no cost; A freeware application 

may or may not have its source code freely available. The program itself does not cost and is 

completely usable without charge, but that doesn’t mean that the program is editable and can 

be transformed to create something new, or inspected to learn more about the inner-workings. 

Freeware might also be restrictive. For example, one program might be free only for private 

use and stop working if it’s found to be used for commercial purposes, or maybe the software 

is restricted in functionality because there’s a paid edition available that includes more 

advanced features. 

Unlike the rights given to free software users, freeware users’ freedoms are granted by the 

developer; some developers might give more or less access to the program than others. They 

also might restrict the program from being used in particular environments, lock down the 

source code, etc. 

Examples:  

 Adobe PDF 

 yahoo messenger 

 Google Talk 

 MSN messenger 
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4.9 SUMMARY 

Computer software provides instructions that tell the computer how to operate. 

Software is also called programs. These programs are usually created using other software 

called programming languages. System software directs all the activities and sets all the rules 

for how the hardware and software work together.  MS  DOS  and  Microsoft  Windows  are 

examples  of  system  software  or  operating  system  software. Application software 

programs work with the operating system software to help us to use our computer to do 

specific types of work such as word processing to type a letter. 

 

4.10 TECHNICAL TERMS 

Software,  System software,  Application software,   freeware, open 

source,  domain. 

 

4.11 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1. Define Software. What are various categories of software 

2. Explain the difference between System Software and Application Software. 

3. Differentiate between Public domain software, freeware, commercial 

software 

Short Notes:   

1. Commercial software 

2. Freeware software 

3. Domain software 
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LESSON- 5 

PROGRAMMING LANGUAGES 

AIMS AND OBJECTIVES 

Upon successful completion of this chapter, student will be able to: 

 Explain the need for programming languages 

 Identify the different generations of programming languages 

 Categorize programming languages 

 What is Language Paradigm 

 Provide examples of programming languages 

 

STRUCTURE 

5.1 Introduction 

 5.1.1 Computer Program 

 5.1.2 Programming Language 

 5.1.3 Types of Programming Languages 

 5.1.4 Computer Programmers 

 5.1.5 Language Paradigm 

5.2 Generations of Programming Languages 

5.3 Summary 

5.4 Technical Terms 

5.5 Self-Assessment Questions 

5.6 Suggested Readings 
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5.1  INTRODUCTION 

A programming language is a formal language comprising a set of strings that produce 

various kinds of machine code output. Programming languages are one kind of computer 

language, and are used in computer programming to implement algorithms such as C, C++, 

Java, and Python. While coding and programming seem to be synonymous at the front, they 

are altogether different from each other. While coding means writing codes from one 

language to another, programming means to program a machine with a given set of 

instructions to run.  

The portion of the language that a computer can understand is called a “binary.” Translating 

programming language into binary is known as “compiling.” Each language, from C 

Language to Python, has its own distinct features, though many times there are 

commonalities between programming languages. 

Programming languages follow grammar called syntax. There are certain basic program code 

elements which are common for all the programming languages 

5.1.1 Computer Program 

Computer Program is a step by step process of designing and developing various sets of 

computer programs to accomplish a specific computing outcome. The process comprises 

several tasks like analysis, coding, algorithm generation, checking accuracy and resource 

consumption of algorithms, etc. The purpose of computer programming is to find a sequence 

of instructions that solve a specific problem on a computer. 

Computer programming is the process of writing, testing, debugging/troubleshooting, and 

maintaining the source code of computer programs. This source code is written in a 

programming language like C++, JAVA, and Perl etc. 

5.1.2 Programming Languages 

Programming language is a vocabulary and set of grammatical rules (syntax) for instructing a 

computer to perform specific tasks. 
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They can be used to create computer programs and design operating systems. The term 

programming language generally refers to high-level languages, such as BASIC, C, C++, 

COBOL, JAVA and Python etc. 

The function of a programming language is write computer programs, which instruct a 

computer to perform some kind of computation, and/or organize the flow of control between 

external devices (such as a printer, a robot, or any peripheral). Programming languages may 

contain constructs for defining and manipulating data structures or for controlling the flow of 

execution. 

5.1.2.1 Elements of a Programming Language 

 Syntax 

A programming language's surface form is known as its syntax. Most programming 

languages are purely textual; they use sequences of text including words, numbers, and 

punctuation, much like written natural languages. On the other hand, there are some 

programming languages which are more graphical in nature, using spatial relationships 

between symbols to specify a program. The syntax of a language describes the possible 

combinations of symbols that form a syntactically correct program.  

 Type System 

A type system defines how a programming language classifies values and expressions 

into types, how it can manipulate those types and how they interact. This generally 

includes a description of the data structures that can be constructed in the language. 

A language is typed if operations defined for one data type cannot be performed on values 

of another data type. An untyped language, such as most assembly languages, allows any 

operation to be performed on any data type. 

 Variables 

Variables in programming tells how the data is represented which can be range from very 

simple value to complex one. The value they contain can be change depending on 

condition. As we know program consist of instructions that tell the computer to do things 
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and data the program use when it is running. Data is constant with the fixed values or 

variable. They can hold a very simplex value like an age of the person to something very 

complex like a student track record of his performance of whole year. 

 Loops 

We can define loop as a sequence of instructions that are repeated continuously till a 

certain condition is not satisfied. How a loop start understand this first a certain process is 

done, to get any data and changing it after that applied condition on the loop is checked 

whether counter reached to prescribed number or not. Basically a loop carry out execution 

of a group of instruction of commands a certain number of times. There is also a concept 

of infinite loop which is also termed as endless loop is a piece of code that lack from 

functional exit and goes to repeat indefinitely. 

 Conditionals 

Conditionals specify the execution of the statements depending on the whether condition 

is satisfied or not. Basically it refers to an action that only fulfil when the applied 

condition on instructions satisfied. They are one of the most important components of the 

programming language because they give freedom to program to act differently every 

time when it execute that depends on input to the instructions. 

 Input/output 

The element of computer programming allow interaction of the program with the external 

entities. Example of input/output element are printing something out to the terminal 

screen, capturing some text that user input on the keyboard and can be include reading 

and writing files. Let’s take a language example to understand the concept of input and 

output. C++ use streams to perform input and output operation in sequential media in 

terms of screen, the keyboard or a file. We can define stream as an entity that can insert or 

extract characters and there is no need to know details about the media associated to the 

stream or any of its internal specification. We need to know about streams is that they are 

source or destination of characters and the characters are accepted sequentially. 

 



 
 
 

Information Technology                                 5.5                                          Programming Languages 

 

 
 

Subroutines and functions: the element of the programming allow a programmer to use 

snippet of code into one location which can be used over and over again. The primary 

purpose of the functions is to take arguments in numbers of values and do some 

calculation on them after that return a single result. Functions are required where you 

need to do complicated calculations and the result of that may or may not be used 

subsequently used in an expression. If we talk about subroutines that return several 

results. Where calls to subroutines cannot be placed in an expression whether it is in the 

main program where subroutine is activated by using CALL statement which include the 

list of inputs and outputs that enclosed in the open and closed parenthesis and they are 

called the arguments of the subroutines.  

 

5.1.3 Types of Programming Languages 

5.1.3.1 Machine Level Language: 

Machine languages are also known as machine code or object code, machine language is a set 

of binary digits or bits that a computer reads and interprets. The only language that a 

computer can understand is machine language. Therefore all references and data should be 

written using binary codes 1 and 0. Binary code is called machine code or machine 

Language. The exact machine language for a program is varies by an operating system. 

Computer programs are written in one or more programming languages, such as C ++, Java, 

or Visual Basic. The computer does not directly understand the programming languages used 

to create computer programs, so the program code must be compiled. Once the code of the 

program has been compiled, the computer can understand it because the code of the program 

has been converted into machine language. 

The compiler checks the entire user-written program (called the source program) and 

produces the complete program in machine language (called the object program). The source 

program is kept intact for possible changes and corrections, and the object program is loaded 

into the computer for execution. 

For example, the machine language program instruction would be: 1011100101011010 
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Typical Machine language Instruction format 

Opcode Operand 

OPCODE (Operation code) tells the computer which operation to perform from the 

instruction set of the computer. 

OPERAND (Address/Location) tells the address of the data on which the operation is to be 

performed. 

 Advantage of Machine Language: 

The only advantage is that program of machine language run very fast because no 

translation program is required for the CPU. 

 Disadvantages of Machine language 

o It is machine dependent i.e. it differs from computer to computer. 

o It is difficult to program and write. 

o It is prone to errors 

o It is difficult to modify. 

5.1.3.2 Assembly Level Language: 

Assembly language, also known as symbolic language, is a low-level programming language 

that allows the user to write a program using alphanumeric mnemonic instructions. It requires 

a translator to translate the language into a machine language can be understood by computer. 

It is easier to remember and write than machine language. 

Using alphanumeric mnemonic codes instead of numeric cods for the instruction in the 

instruction set e.g. using ADD instead of 1101 (binary) or 13 (decimal) for instruction to add.  

Allowing storage location to be represented in form of alphanumeric address instead of 

numeric address e.g. representing memory locations 1000, 1001 etc. 

 

 Assembler: It is a computer program which converts or translate assembly language 

into machine language. It assembles the machine language program in the main 

memory of the computer and makes it ready for execution. 
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 Assembly language program: The main memory in a computer is called Random 

Access Memory. It is known as RAM. This is the part of the computer that stores 

operating system software, software application and other information for the CPU to 

have fast and direct access when needed to perform tasks. 

 Advantages of Assembly language 

o The symbolic programming of Assembly Language is easier to understand and 

saves a lot of time and effort of the programmer. 

o It is easier to correct errors and modify program instructions. 

o Assembly Language has the same efficiency of execution as the machine level 

language. Because this is one-to-one translator between assembly language 

program and its corresponding machine language program. 

 Disadvantages Assembly Language: 

o One of the major disadvantages is that assembly language is machine 

dependent. A program written for one computer might not run in other 

computers with different hardware configuration.  

o Long programs written in such languages cannot be executed on small sized 

computers. 

o It takes lot of time to code or write the program, as it is more complex in 

nature. 

5.1.3.3 High Level Languages 

High level languages are similar to the human language. Unlike low level languages, high 

level languages are programmers friendly, easy to code, debug and maintain. 

High level language provides higher level of abstraction from machine language. They do not 

interact directly with the hardware. Rather, they focus more on the complex arithmetic 

operations, optimal program efficiency and easiness in coding. 

Low level programming uses machine friendly language. Programmers writes code either in 

binary or assembly language. Writing programs in binary is complex and cumbersome 

process. Hence, to make programming more programmers friendly. Programs in high level 

language is written using English statements. 
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High level programs require compilers/interpreters to translate source code to machine 

language. We can compile the source code written in high level language to multiple machine 

languages. Thus, they are machine independent language. 

Today almost all programs are developed using a high level programming language. We can 

develop a variety of applications using high level language. They are used to develop desktop 

applications, websites, system software’s, utility software’s and many more. High level 

languages are grouped in two categories based on execution model – compiled or interpreted 

languages. 

The following figure depicts classification of high level language on the basis of execution 

model. 

 

 We can also classify high level language several other categories based on programming 

paradigm.  

 

 Advantages of High level language 

o High level languages are programmer friendly. They are easy to write, debug 

and maintain. 

o It provide higher level of abstraction from machine languages. 

o It is machine independent language. 

o Easy to learn. 

o Less error prone, easy to find and debug errors. 

o High level programming results in better programming productivity. 
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 Disadvantages of High level language 

o It takes additional translation times to translate the source to machine code. 

o High level programs are comparatively slower than low level programs. 

o Compared to low level programs, they are generally less memory efficient. 

o Cannot communicate directly with the hardware. 

5.1.4 Language Paradigm 

Language paradigms were associated with classes of languages. First the paradigms are 

defined. Thereafter, programming languages according to the different paradigms are 

classified. The language paradigms are divided into two parts, imperative and declarative 

paradigms as shown in the Figure. 

 

 Imperative paradigm: The meaning of imperative is “expressing a command or 

order”, so the programming languages in this category specify the step-by-step 

explanation of command. 

o Procedural paradigm: Procedural languages are statement oriented with the 

variables holding values. In this language the execution of a program is 

modeled as a series of states of variable locations. 

o Object oriented paradigm: The Object Oriented paradigm is centered on 

the concept of the object. Everything is focused on objects. 
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 Declarative paradigm: In this paradigm programs declare or specify what is to be 

computed without specifying how it is to be achieved. Declarative programming is 

also known as Value-oriented programming. 

o Functional paradigm: In this paradigm, a program consists of a collection 

of functions. A function just computes and returns a value. 

o Logic paradigm: In this paradigm programs only explain what is to be 

computed not how to compute it. Here program is represented by a set of 

relationships, between objects or property of objects known as predicate 

which are held to be true, and a set of logic/clauses (i.e. if A is true, then B 

is true). Basically logic paradigm integrates data and control structures. 

 

 

5.2 GENERATIONS OF PROGRAMMING LANGUAGES 

There are five generations of programming language. 

5.2.1 First Generation Languages 

Sometimes referred to as machine code or object code, machine language is a collection of 

binary digits or bits that the computer reads and interprets. Machine language is the only 

language a computer is capable of understanding. 

First Generation languages are called as machine code or object code. Machine language is a 

set of binary digits or bits that a computer reads and describes. The only language that a 

computer can understand is machine language. 

5.2.2 Second Generation Languages 

Assembly language is a low-level programming language for a particular computer or other 

programmable device specific to a particular computer architecture, as opposed to most high-

level programming languages, which are usually portable on multiple systems. The assembly 

language is converted into an executable machine code by a utility program that refers to 

assemblers such as NASM, MASM. 
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5.2.3 Third Generation Languages 

High-level language is a programming language designed to simplify computer 

programming. This is "high-level" because it removes many steps from the actual code 

running on the computer processor. High-level source code contains easy-to-read syntax, 

which is then converted to low-level language, which is recognized and executed by a 

specific CPU. 

Example: C, C++, Java, Visual Basic and JavaScript 

5.2.4 Fourth Generation Languages 

The fourth generation programming language (4GL) is any computer programming language 

that belongs to the class of languages which are considered to be advanced over the third 

generation programming languages (3GL). Each programming language generation aims to 

provide a higher level of capture of internal computer hardware details, making the language 

more programmer-friendly, powerful and versatile.  Languages referred to as 4GL may 

support database management, report generation, mathematical optimization, GUI 

development, or web development. Sometimes 4GL is a subset of a domain-specific 

languages. 

Example: Perl, Python, Ruby, SQL, MatLab 

5.2.5 Fifth Generation Languages 

Fifth generation programming language (5GL) is any programming language based on 

problem solving using programmed constraints, rather than using an algorithm written by the 

programmer. Fifth generation languages are most constraint-based and logic programming 

and declarative languages. Fifth generation languages are also designed to solve a given 

problem without a programmer. This way, the user only has to worry about what problems 

need to be solved and what situations need to be addressed, without having to worry about 

how to implement a routine or algorithm to solve them. Fifth generation languages are mainly 

used in artificial intelligence research. 

Example: OPS5 and Mercury programming language. 
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5.9 SUMMARY 

A programming language must be simple, easy to learn and use, have good readability and 

human recognizable. A programming language must be consistent in terms of syntax and 

semantics. Programming languages are broadly categorized into three types − Machine level 

language. Assembly level language. High-level language. Each phase of improved made in 

the development of the programming languages can be referred to as a generation. The 

programming language in terms of their performance reliability and robustness can be 

grouped into five different generations. 

 

5.10 TECHNICAL TERMS 

Program, 3GL, 4GL, 5GL, Language Paradigm, syntax, type system, imperative 

paradigm, Declarative Paradigm 

5.11 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1. Explain various type of programming languages 

2. What is Generation? What are types of programming language Generations? 

 

 Short Notes:   

1. Language Paradigm 

2. Differentiate 4GL and 5GL 

3. Elements of Programming Languages 
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LESSON- 6 

Microsoft Word 

AIMS AND OBJECTIVES 

After reading this chapter, the student will be able to do the following in MS Word: 

 Understand the basic features of Microsoft Word. 

 Create a new document, set basic document parameters, and save his work 

 Edit an existing document with techniques such as moving text, using find and 

replace, modifying text, and using indentation and tabs and Mail Merge feature. 

 

STRUCTURE 

6.1 Introduction 

6.2 Features of MS Word 

6.3 Parts of Word Window 

 6.3.1 Creating a document 

 6.3.2 Saving a document 

 6.3.3 Opening a document 

 6.3.4 Printing a document 

6.4 Formatting 

 6.4.1 Formatting of Text and Paragraph 

6.4.2 Bullets and Numbering 

6.4.3 Editing  

6.4.4 Moving and Copying  

6.4.5 Find and Replace Text 

6.5  Tables 

6.6 Insertion of Pictures 

6.7      Mail Merge 

6.8 Summary 

6.9 Technical Terms 

6.10 Self-Assessment Questions 

6.11 Suggested Readings 
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6.1 INTRODUCTION 

Microsoft Word is a word processing application that is part of the Microsoft Office 

suite. Microsoft Office Suite is a powerful set of applications designed to provide great tools 

for almost every potential business task from small to large organizations. So, the interface in 

all applications is consistent. Generally, it helps users move from application to application to 

manage their various business tasks 

Microsoft Word is word processing application to create and edit letters, articles, 

newsletters, flyers, and any other text-based document. 

 

6.2  FEATURES OF MS-WORD 

 

The following are the main features of a Word Processor  

 Using word you can create the document and edit them later, as and when required, 

by adding more text, modifying the existing text, deleting/moving some part of it. 

 Changing the size of the margins can reformat complete document or part of text. 

 Font size and type of fonts can also be changed. Page numbers and Header and Footer 

can be included. 

 Paragraphs or text can be copied /moved throughout the document. 

 Spelling can be checked and modified through the spell check facility. 

 Multiple document/files can be merged. 

 Tables can be made and included in the text. 

 It also provides online help of any option. 

 Word also has the facility of macros. Macros can be either attached to some 

function/special keys or to a tool bar or to a menu. 

 Multiple copies of letters can be generated with different addresses through the mail-

merge facility. 

Microsoft Office 2007 is a departure from previous versions. With this product, Microsoft 

redesigned the user interface and changed the way users work with programs in the 

office. File, edit and view menus are gone; Menus, toolbars and workflows have been 

replaced with new features listed below. 

 6.2.1 The Ribbon 

In Microsoft Word, Excel, PowerPoint, and Access, and in the mail composer/editor 

of Office Outlook, the menus (e.g., File, Edit, and View) and toolbars have been 

replaced by the Ribbon. This Ribbon groups commands previously found in menus or 

toolbars into collections based on activities. 

 

 6.2.2 The Microsoft Office Button 
The Microsoft Office Button is a single place for the most commonly used commands 

in any office program, such as New, Open, and Save. The Home tab contains 
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application-specific authoring commands. The Office Button menu, however, 

contains file-level commands such as saving the file, naming it, or printing. 

 
 

6.2.3  Contextual Tabs 

Contextual tabs replace menus (e.g., File, Edit, View), and reside on the Ribbon. 

Contextual tabs are not fixed, but change based on the situation. Microsoft explains 

contextual tabs as follows: "Certain sets of commands are only relevant when objects 

of a particular type are being edited. For example, the commands for editing a chart 

are not relevant until a chart appears in a spreadsheet and the user is focusing on 

modifying it. In current versions of Microsoft Office applications, these commands 

can be difficult to find. Contextual tabs only appear when they are needed and make it 

much easier to find and use the commands needed for the operation at hand." 

 

 
 
 

6.2.4 Galleries 

 

Galleries are graphical representations of formatting options you can apply to given 

elements in an Office document. Galleries simplify the act of formatting a document's 

elements by placing them in one location. Some Galleries require no fewer clicks than 

in earlier Office versions, but others combine what would have been many individual 

settings and commands into a single click. 

 

 
 

 
6.2.5 Live Preview 

 

As we hover our pointer over a set of Gallery results, Live Preview displays the effect 

of an editing or formatting change. It provides an on-the-fly preview of the document 

in question (not in a preview window). For example, suppose we type a page of text 

and then go to the Page Layout Gallery. As you hover over the built-in themes, your 

document changes in response to each one. 
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6.2.6  Mini Toolbar 

The Mini toolbar, which appears near any selected text, provides access to frequently 

used formatting commands. If you move your cursor away from it, the toolbar 

becomes semi-transparent so that you can see whatever appears below it. When you 

move the mouse over it, the toolbar becomes opaque. It also appears above the 

contextual menu if you right-click selected text. 

 

 

6.3  PARTS OF WORD WINDOW 
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1. Office Button 

A button that provides access to menu commands in Word. The Microsoft Office 

Button replaces the File button in previous versions. Here is where you will find commonly 

known features such as New, Open, Save, Print and Recent Documents. This is also where 

you will find the Word Options commands that were previously located in the Tools menu in 

previous versions. 

2. Ribbon 

An area across the top of the screen that makes almost all the capabilities of Word 

available in a single area. The Ribbon replaces the menus and toolbars in previous versions. 

The Ribbon exposes most of the features that used to be hidden in File menus. The Ribbon 

makes it easier to see and find commands to format your document. The Ribbon can be 

reduced to a single line of tabs by pressing CTRL + F1. 

3. Tab Selector button 

 It is also called the tab indicator, is a button to the left of the ruler that 

provides tab marker options. When aligning or positioning text, never do so using the 

spacebar as it can cause formatting problems. 

4. Rulers 

The Ruler is located below the Ribbon around the edge of the document. It is used to 

change the format of the document, i.e. it helps you align the text, tables, graphics and other 

elements of your document. It uses inches or centimeters as the measurements unit and gives 

you an idea about the size of the document. 

5. Document 

The document area is the blank section of a Word processor or other document 

program that allows the user to create content. Below is an example of a blank Microsoft 

Word document with the white page being the document area. When a document is opened, 

you can begin typing, and your text appears in the document 

6. Status Bar 

A horizontal bar at the bottom of an active window that gives details about the active 

documen 

7. Task Bar 

The task bar, which appears at the bottom of your screen, enables you to quickly and 

easily access programs such as Microsoft Word. 
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8. View Toolbar 

A toolbar that enables, adjusts, and displays different views of a document’s content.  

9. Zoom  

 A button that magnifies or reduces the contents in the document window. 

10. View Ruler Button  

 We can view horizontal and vertical rulers when the document expanded than page 

view.  

 11. Screen split Button 

Use this handy button to split your screen and save yourself scrolling up and down 

a Word document. You can split a document into two sections on one screen by applying 

horizontal sections. 

12. Scroll Bars 

A vertical bar on the right side of a window or a horizontal bar at the bottom of a 

window that is used to move the window contents up and down or left and right. 

13. Right Indent 

The Right indent controls the space between the paragraph and the right margin and 

has a marker of its own. It is indicated by a single triangle on the Ruler at the 

current right margin. Click and drag it to change the margin.  

14. Group 

A Group of buttons on a tab that are exposed and easily accessible. These buttons 

were formally embedded in menus on the Menu Bar 

15. Dialogue Box launcher 

A button that launches a dialog box containing options for refining a command. 

16. Title Bar 

 A horizontal bar at the top of an active document. This bar displays the name of the 

document and application. At the right end of the Title Bar is the Minimize, Restore and 

Close buttons. 

17. Quick Access Toolbar 

 A customizable toolbar at the top of an active document. By default the Quick Access 

Toolbar displays the Save, Undo, and Repeat buttons and is used for easy access to frequently 

used commands. To customize this toolbar click on the dropdown arrow and select the 

commands you want to add. 

 



 

 

 

Information Technology                                    6.7                                                  MS -Word 

 

 

 

18. Tab 

 An area on the Ribbon that contains buttons that are organized in groups. The default 

tabs are Home, Insert, Page Layout, Reference, Mailings, Review and View. 

19. First Line Indent 

The First Line indent is used to indent the first line of a paragraph or of every 

paragraph. 

20. Hanging Indent 

A Hanging indent, also known as a second line indent, sets off the first line of a 

paragraph by positioning it at the margin, and then indenting each subsequent line of the 

paragraph. 

 

6.3.1 Creating a document 

 Click the Microsoft Office button. 

 Select New. The New Document dialog box appears. 

 Select Blank document under the Blank and recent section. It will be highlighted by 

default. 

 Click Create. A new blank document appears in the Word window 
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6.3.2 Saving a document 

 

 Click the MS 2007 logo which is situated in the upper-left corner of your MS Word 

program.  

 

 Mouse-over Save As and then left-click on Word 97 – 2003 Document. 
 

 
 

 In the Save As window, select a location on your local computer where you can later 

retrieve the file. 

 

 
 

 In the File name text box, ensure that the name of the file is using your class’ naming 

convention and that it ends with a .doc extension. The Save as type drop-down should 

have Word 97 – 2003 Document (*.doc) selected. 

 

 Click the Save button. You can now close the Word document if you have finished your 

work. When you need to upload your file, retrieve it from the location on your computer 

selected in above step. 
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6.3.3 Opening a document 

 

 Click the Microsoft Office button. Click Open. 

 

 
 

 Click the Files of type drop-down list and select the file type to open 

 

 
 

 Click the file. Click Open to open the file in Word. 
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6.3.4 Printing a document 

 Click the Microsoft Office button Microsoft Office button. 

 In the menu that opens, click Print. 

 The Print dialog opens. 

 Click OK to print the document. 

 

 

6.4 FORMATTING 

 

Formatting is the fine art of making your documents efficient and attractive. It 

enhances the presentation of the information. We can apply configuration to each element of 

your document from a single letter to whole paragraphs. Body text should be readable and 

light on the eyes. Captions should be large and bold and they should be consistent throughout 

your document. Important words should resonate with importance. Quotes and references 

should be set from other text. 

Text formatting data may be qualitative (e.g., font family), or quantitative (e.g., font 

size, or color). It may also indicate a style of emphasis (e.g., boldface, or italics), or a style of 

notation (e.g., strikethrough, or superscript). 

 

6.4.1 Formatting of Text and Paragraph 

The first step in formatting any amount of text or an entire document is selecting the 

portion of text that needs formatting. 

We can do boldface a section, add italics, underline, change the color, and change the 

font, highlight, cut, copy and paste. 

 

To do any formatting on text, we must first select the text that the formatting will be 

applied to within the document. Selecting text is easy and done in three easy steps. 

1.      Move the cursor to the beginning of the text that you want to select.  

2.      Click and hold in the left button on your mouse.  

3.      Drag it over the text you want to select. It will highlight the selected text in blue.   

         Simply release the mouse button when you are finished selecting text. 
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If we want to select the entire document, simply click on the 'Home' tab and click 'Select' on 

the far right (located below 'find' and 'replace) as seen in the picture below. We will then 

select 'select all'. This will highlight all our text for formatting. Also note that we can select 

objects or text with similar formatting as our selected text when clicking on 'Select.' 
 

6.4.1.1  Formatting Font Style 

 We can apply a font to either an entire document or to certain portions of a document.  

 To apply a font, click on the Home tab. We'll see the toolbars, or groups, as pictured 

below. 

 
 The type of font we're currently using will appear. In the picture above, the current 

type of font is Calibri. We can click on the arrow in that window to display other 

types of font available to use. 

 To change the type of font within a document or for the entire document, simply 

select the text to be formatted, and then we can select our new font. 

 
6.4.1.2  Formatting Font Size 

 First we have to select the text which we want to modify.  

 Now Left-click the drop-down arrow next to the font size box on the Home tab.  

 The font size drop-down menu appears. Move cursor over the various font sizes.  

 A live preview of the font size will appear in the document.  

 Left-click the font size what we want to use. The font size will change in the 

document. 
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6.4.1.3  Formatting Font Color 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font color box on the Home tab. The font 

color menu appears. 

 Move your cursor over the various font colors. A live preview of the color will appear 

in the document. 

 Left-click the font color you want to use. The font color will change in the document. 

 Your color choices aren't limited to the drop-down menu that appears. Select More 

Colors at the bottom of the list to access the Colors dialog box. Choose the color you 

want, then click OK. 

 
6.4.1.4  The Bold, Italic, and Underline commands: 

 Select the text you want to modify. 

 Click the Bold, Italic, or Underline command in the Font group on the Home tab. 

 

 
 

 

6.4.1.5  To change the text case: 

 Select the text you want to modify. 

 Click the Change Case command in the Font group on the Home tab. 

 Select one of the case options from the list. 

 
 

6.4.1.6   To change text alignment: 

 Select the text you want to modify. 

 Select one of the four alignment options from the Paragraph group on the Home tab. 

 Align Text Left: Aligns all of the selected text to the left margin 

 Center: Aligns text an equal distance from the left and right margins 

 Align Text Right: Aligns all of the selected text to the right margin 

 Justify: Aligns text equally to the right and left margins; used in many books, 

newsletters, and newspapers 
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6.4.2 Bullets and Numbering 

A bullet is a symbol placed before text, especially in a list, to emphasize it. Bullets or 

Numbering are used to sort a list of items, or to emphasize certain points or lists in a 

document. Adding bullets or numbers to a list makes it easier to read the list. We can create 

multilevel lists, in which an outline of a document is arranged in a hierarchical order on the 

list. 
 

6.4.2.1  To insert a new list: 

 Select the text you want to format as a list. 

 Click the Bullets or Numbering commands on the Home tab. 

 Bulleted or Numbered Lists 

 Left-click the bullet or numbering style you want to use. It will appear in the 

document. 

 
 Position your cursor at the end of a list item, and press the Enter key to add an item to 

the list. 

To remove numbers or bullets from a list, select the list and click the Bullets or 

Numbering commands. 
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6.4.2.2    To select an alternate bullet or numbering style: 

 Select all of the text in an existing list. 

 Click the Bullets or Numbering commands on the Home tab. 

 Left-click to select an alternate bullet or numbering style. 

 
6.4.2.3   To use a symbol as a bullet: 

 Select an existing list. 

 Click the Bullets command. 

 Select Define New Bullet from the list. The Define New Bullet dialog box appears. 

 Click the Symbol button. The Symbol dialog box appears. 

 

 
 

 Click Symbol 

 Click the Font: drop-down box, and select a font category. 

 

 
 

 Select Font Drop-down 

 Left-click a symbol to select it. 
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 Click OK. The symbol will now appear in the Preview section of the Define New 

Bullet dialog box. 

 Click OK to apply the symbol to the list in the document. 

We can use a picture as a bullet. Click the Picture button in the Define New Bullet dialog 

box, and then locate the image file on your computer. 

 

 

6.4.3 Editing  

 

Ability to change text by adding, deleting and rearranging letters, words, sentences and 

paragraphs. The main operation performed by users on word processors is text editing. 

 
6.4.3.1   To insert text: 

Move your mouse to the location where you want text to appear in the document. 

Left-click the mouse. The insertion point appears. 

Type the text you want to appear. 

 
6.4.3.2.  To delete text: 

Place your cursor next to the text you want to delete. 

Press the Backspace key on your keyboard to delete text to the left of the cursor. 

Press the Delete key on your keyboard to delete text to the right of the cursor. 

 

6.4.4 Moving and Copying  

We can move the selected text from its existing position to the new destination in the 

document. This feature of Microsoft word 2007 helps to reduce the time and efforts involved 

in re-typing the similar text. Using this we can copy the text from one location to another. 

Keeping the text at original place unchanged.  

 
6.4.4.1   Moving Text 

 Select the text to be moved. 

 Click the Cut option from the Clipboard group under the Home tab. 

 The selected text will disappear from the document. 

 Bring the cursor to the new position where you want to shift the text. 

 Click Paste option from the Clipboard group. 

 The text will appear at the cursor position 

 
6.4.4.2   Copying Text 

 Select the text to be copied. 

 Click Copy option in the clipboard group under the Home Tab. 

 Bring the cursor to the new location where you want to copy the text. 

 Click paste option in the clipboard group 

 

6.4.5 Find and Replace Text 

We can search any word or text in our document at different locations. We can also replace a 

particular word or text after finding it in our document with a new word or text 
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6.4.5.1   Finding Text 

 Click Find option in the Editing group under Home Tab to open Find and Replace 

dialog box. 

 In the Find what text box, type the word you want to search. 

 Now click the Find Next button. The pointer will move to the first occurrence of 

that word. 

 Use Find Next button to locate other occurrences of the same word in the 

document. 

6.4.5.2   Replacing Text 

 Click Replace option in the Editing group under the Home tab. 

 Find and Replace dialog box will appear. 

 Type the text or word that you want to change in the Find What box. 

 Type the New word or text in the Replace with box. 

 Click Find Next button to search the word and then click Replace button to change it with 

the new word. 

 Replace All button will change the word at once for all the occurrences. 

 

6.5 TABLES 

MS Word tables are used to place information into rows and columns. We can also use tables 

as a way to position images that would otherwise be hard to place in the overall layout of a 

document. Word tables are the perfect easy way to display complex visual information in a 

page easily. 

6.5.1 Insert or create a table 

6.5.1.1 Use table templates 

We can use table templates to insert a table that is based on a gallery of preformatted tables. 

Table templates contain sample data to help you visualize what the table will look like when 

we add our data. 

 Click where we want to insert a table. 

 On the Insert tab, in the Tables group, click Table, point to Quick Tables, and then 

click the template that you want. 

 Replace the data in the template with the data that you want. 

6.5.1.2 Use the Table menu 

 Click where you want to insert a table. 

 On the Insert tab, in the Tables group, click Table, and then, under Insert Table, drag 

to select the number of rows and columns that you want.  
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6.5.1.3 Use the Insert Table command 

You can use the Insert Table command to choose the table dimensions and format before you 

insert the table into a document. 

 Click where you want to insert a table. 

 On the Insert tab, in the Tables group, click Table, and then click Insert Table. 

 Under Table size, enter the number of columns and rows. 

 Under AutoFit behavior, choose options to adjust the table size. 

6.5.2 Create a table 

We can create a table by drawing the rows and columns that you want or by converting text 

to a table. 

6.5.2.1  Draw a table 

We can draw a complex table — for example, one that contains cells of different heights or a 

varying number of columns per row. 

 Click where you want to create the table. 

 On the Insert tab, in the Tables group, click Table, and then click Draw Table. 

 The pointer changes to a pencil. 

 To define the outer table boundaries, draw a rectangle. Then draw the column lines 

and row lines inside the rectangle. 

 To erase a line or block of lines, under Table Tools, on the Design tab, in the Draw 

Borders group, click Eraser. 

 Click the line that you want to erase. To erase the entire table, see Delete a table or 

clear its contents. 

 When you finish drawing the table, click in a cell and start typing or insert a graphic. 
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6.5.2.2 Convert text to a table 

Insert separator characters — such as commas or tabs — to indicate where you want to divide 

the text into columns. Use paragraph marks to indicate where you want to begin a new row. 

For example, in a list with two words on a line, insert a comma or a tab after the first word to 

create a two-column table. 

 Select the text that you want to convert. 

 On the Insert tab, in the Tables group, click Table, and then click Convert Text to 

Table. 

 In the Convert Text to Table dialog box, under Separate text at, click the option for 

the separator character that you used in the text. 

 Select any other options that you want.  

6.5.3 Add a cell 

 Click in a cell that is to the right of or above where you want to insert a cell. 

 Under Table Tools, on the Layout tab, click the Rows & Columns Dialog Box 

Launcher. 

6.5.4 Add a row above or below 

 Click in a cell above or below where you want to add a row. 

 Under Table Tools, on the Layout tab, do one of the following: 

 To add a row above the cell, click Insert Above in the Rows and Columns group. 

 To add a row below the cell, click Insert Below in the Rows and Columns group. 

 

6.5.5 Add a column to the left or right 

 Click in a cell to the left or right of where you want to add a column. 

 Under Table Tools, on the Layout tab, do one of the following: 

 To add a column to the left of the cell, click Insert Left in the Rows and Columns 

group. 

 To add a column to the right of the cell, click Insert Right in the Rows and Columns 

group.  

6.5.6 Delete a cell 

 Select the cell that you want to delete by clicking its left edge. 

 Under Table Tools, click the Layout tab. 

 In the Rows & Columns group, click Delete, and then click Delete Cells. 
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6.5.7 Delete a row 

 Select the row that you want to delete by clicking its left edge. 

 Under Table Tools, click the Layout tab. 

 In the Rows & Columns group, click Delete, and then click Delete  Rows. 

6.5.8 Delete a column 

 Select the column that you want to delete by clicking its top gridline or top border. 

 Under Table Tools, click the Layout tab. 

 In the Rows & Columns group, click Delete, and then click Delete Columns.  

6.5.9 Merge cells 

You can combine two or more table cells located in the same row or column into a single 

cell. For example, you can merge several cells horizontally to create a table heading that 

spans several columns. 

 Select the cells that you want to merge by clicking the left edge of a cell and then 

dragging across the other cells that you want. 

 Under Table Tools, on the Layout tab, in the Merge group, click Merge Cells. 

6.5.10 Split cells 

 Click in a cell, or select multiple cells that you want to split. 

 Under Table Tools, on the Layout tab, in the Merge group, click Split Cells.. 

6.5.11 Apply Table Styles 

Apply Table Styles Pre-built table styles can be applied to any table. The Table Styles are 

located on the Table Tools, Design tab, Table Styles Group 
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6.5.12 Repeat a Table Heading on Subsequent Pages  

 You can have Headings repeat on subsequent pages for tables that span multiple 

pages. 

 Select the row of text that you want to use as a table heading.  

 NOTE: the selection must include the first row of the table.  

 Next, choose Repeat Header Rows from the Data Group of the Table Tools, Layout 

tab. 

 

 

 

6.6 INSERTION OF PICTURES 

Adding images from a variety of sources, including scanned images, images saved from the 

Internet, and clip art, is easy in Word 2007. The extensive Clip Art Gallery provides easy 

access to image. 

6.6.1 Adding Images 

 Click the location where we want the image to appear 

 From the Insert command tab, in the Illustrations section, click Picture Picture button. 

The Insert Picture dialog box appears. 

 

 Using the Look in pull-down list, locate and select the desired image 

 Click INSERT.  The image appears in your document. 

 

6.6.2 Positioning Images 

Once we have inserted an image into our document, we can easily position or resize it as 

needed. In order to drag images freely in Word, the wrapping style of the image must not be 

In line with text. 

 Click and hold the center of the image 
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 The cursor turns into a four-headed arrow when you are able to move the image. 

 Drag the image to the desired location 

 Release the mouse button 

The image is now in the desired location. 

 

6.6.3 Wrapping Text 

Once we have inserted a picture into our document, we can control the way text will wrap 

around it. Word has two options for wrapping text around an image: the quick menu option 

and the command tab option. 

Wrapping Text: Quick Menu Option 

 Right click the image » select Text Wrapping » the desired wrapping option 

Wrapping Text: Command Tab Option 

Once you insert an image, the Picture Tools Format tab appears. 

 On the Picture Tools Format tab, click TEXT WRAPPING text wrapping button» 

select the desired wrapping option 

The In Line With Text option forces an image to align with the line of text in which it was 

inserted, making it impossible to move the image freely. To allow an image to be moved 

freely within your document, choose an option other than In Line With Text. 
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6.6.4 Picture Tools Command Tab Options 

Once we have inserted a picture into our document, many options can enhance the look of 

your image. The Picture Tools command tab lets you change the appearance of our image by 

providing options such as line style, transparency, contrast, changing color, and cropping. 

To access the Pictures Tools command tab 

 Select an image 

 Under the Picture Tools tab, the Format command tab appears. 

Adjust Group:  

Allows you to edit the picture (e.g., adjust brightness, contrast, color), and also undo any 

changes you make. 

 

Picture Styles Group: 

From here we can apply preset or custom picture styles (e.g., image shape, border, effects). 

 

Arrange Group: 

Let us to reposition, change text wrapping, arrange layers, and rotate objects. 

 

Size Group: 

This is where we can change image size with the Crop tool or by specifying dimensions in 

the Height and Width text boxes. Changes made in the text boxes are proportional (i.e., if we 

change image height, its width changes proportionally). 
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6.6.5 Insert a ClipArt 

Clip art refers to a graphic or a picture that you can insert in your document. It comes in 

different formats and styles. It is used to enhance the appearance of a document.  

 Place the cursor where you want to insert the clip art 

 Select the Insert tab 

 In Illustrations group click the Clip Art command. 

 

 A task pane appears on the right side of document 

 Enter the keyword in 'Search for' field and select the suitable option in 'Search in' and 

'Results should be' fields 

 Click Go, clip art menu will appear 

 Select the desired clip art with a left click 
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6.7 MAIL MERGE 

Mail Merge is a useful tool that will allow us to easily produce form letters, labels, envelopes, 

and more by using information stored in a list, database, or spreadsheet. It is the process of 

merging a list of data with a template. 

 

The mail merge process involves two files 

The Main Document which contains the text and graphics that are the same for each version 

of the merged document. 

Data Source is a file that contains the information to be merged into a document. For 

example, the names and addresses of the recipients of a letter. 

 

6.7.1 Form Letters 

 Open Microsoft Word 

 Type the letter with all needed text and formatting leaving areas for the data source 

data blank (name, address…) 

 Click the Mailings tab 

 Click Start Mail Merge 

 Click Step by Step Mail Merge Wizard 

 

 
 

The Mail Merge task pane appears on the right of your screen. Note there are 6 steps.  
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Step 1 

 Click Letters for the document type 

 Click Next: Starting document 

Step 2 

 Click Use the current document under Select starting document 

 Click Next: Select recipients 

Step 3 

The recipients can come from either an existing Excel file, or Access table or youcan create a 

new list. 

 If Using an Existing List: 

1) Click Use an existing list under Select recipients 

2) Click Browse 

3) Select the file 

4) Click Open 

Mail Merge Recipients opens showing the name, city and mails from your file 
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5) Click OK 

6) Click Next: Write your letter 

 To Type a New List: 

1) Click Type a new list under Select recipients 

2) Click Create 

3) Click Customize Columns to modify the list of fields 
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4) Delete any unnecessary field names and/or add new ones 

 

5) Click OK 

6) Type records here hitting TAB to advance to the next field and to continue adding 

new records 

7) Click OK 

8) Click Save 

The recipients list will be saved as a separate file as a Microsoft Access file type. It is 

saved in the My Data Sources folder. It is recommended to save the file in this folder. 
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9) Click Next: Write your letter 

Step 4 

 Click the location in your document where the data from the mail merge fields need to 

be inserted 

 Click Address block… 

 Select the address elements you want included 

 Click OK 

 

The field name will look like this: <<AddressBlock>> 

The Address block will insert the following fields including any necessary punctuation: 

Name, city and email address. 

 

If your fields do not match the ones listed above or you have additional fields, click More 

items… 

 Click on the field from the list 

 Click Insert 

 Click Close 

 



 

 

 

Information Technology                                    6.29                                                  MS -Word 

 

 

 

The field name will look like this - «Name».  Repeat this step until all fields have 

been inserted. Remember to put spaces and punctuation where needed. 

 Click Next: Preview your letters 

Step 5 

Here is where we can preview the first page with the fields filled in. 

 Click Next: Complete the merge 

Step 6 

To Complete the Merge: 

 Click Print to send directly to the printer 

 Click Edit individual letters to create a new file 

Remember to save your document as you go. The next time you open your document and 

click on Step by Step Mail Merge, the data file will be attached. 

 

6.7.2 Creating Labels 

 Open a new blank document 

 Click the Mailings tab 

 Click Start Mail Merge 

 Click Step by Step Mail Merge Wizard 

Step 1 

 Click Labels for the document type 

 Click Next: Starting document 

Step 2 

 Click Label options under Change document layout 

 Choose the label style you are using 

 Click OK 

 Click Next: Select recipients 
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Step 3 

 Click Use an existing list under Select recipients 

 Click Browse 

 Select the file that contains the names and addresses 

 Click OK 

 Click Next: Arrange your labels 

Step 4 

 Click in the first label box and click on either Address block or More items to insert 

the data fields 

 Click Update all labels to include the fields on all labels 

 Click Next: Preview your labels 

Step 5 

Here is where you can preview the labels. 

 Click Next: Complete the merge 

Step 6 

 Click Print to send directly to the printer or we can create a new file by click on the 

Edit individual labels. 
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6.8 SUMMARY 

MS Word is a popular word-processing program used primarily for creating documents 

such as letters, brochures, quizzes and Posters. There are many simple but useful features 

available in Microsoft Word to perform the work easily. 

 

6.9 TECHNICAL TERMS 

Formatting, Window, Data Source, Mail Merge, Font Effects, Table Auto format, 

Template, Word Processing, Clip Art. 

 

6.10 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1) Explain the method for creating and editing word document with example. 

2) Discuss Find and Replace in MS Word with example. 

3) Explain the mail merge concept in MS Word 

 Short Notes:   

1. Ways to create a table 

2.   Insert a ClipArt 

3. Use of Mail Merge 

4. Undo and Redo 

5. Various Keyboard shortcuts in MS Word 

 

6.11   SUGGESTED READINGS 

1. MS-Office S.S. Srivastava 

2. Microsoft Office 2007 Fundamentals, 1st Edition By Laura Story, Dawna Walls 

 

 

AUTHOR: Dr. UDUGA SURYA KAMESWARI 

 



LESSON- 7 

Microsoft Excel 

AIMS AND OBJECTIVES 

After reading this chapter, the student will be able to do the following in MS Excel 

 Indicate the names and functions of the Excel interface components. 

 Enter and edit data. 

 Format data and cells. 

 Construct formulas, including the use of built-in functions, and relative and absolute 

references. 

 Create and modify charts. 

 Preview and print worksheets 

 

STRUCTURE 

 

7.1 Introduction 

 

7.2 Features of Excel 

 

7.3 Parts of Excel window 

 

7.4 Workbooks 

 7.4.1 Creating, Opening and Saving a Workbook 

 

7.5 Worksheets 

 7.5.1 Rows and columns 

 7.5.2 Inserting and Deleting rows and columns and cells 

 7.5.3 Entering labels and values  

 

7.6 Formatting 

 7.6.1 Adjusting row height and column width 

 7.6.2 Formatting cell values 

 

7.7 Formulas 
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 7.7.1 Operators used in formula 

 7.7.2 Cell references in formula 

 

7.8 Functions 

 7.8.1 Mathematical and Statistical  

 7.8.2 Logical 

 7.8.3 Text functions 

 

7.9 Charts:  

7.9.1 Different types of charts 

7.9.2 Creating a chart 

 

7.10 Summary 

 

7.11 Technical Terms 

 

7.12 Self-Assessment Questions 

 

7.13 Suggested Readings 
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7.1 INTRODUCTION 

 

A sheet containing data in the form of rows and columns is called spreadsheet. 

Microsoft Excel or MS Excel, a part of Microsoft Office package, is an electronic spreadsheet 

program. It is used to organize data in an easy and concise manner. It is used by businessmen 

and individuals for storing data and its interpretation. This program helps in doing the tasks at 

the faster speed as all the calculations are performed using formulas and functions. It has 

many built-in features which can even help in performing complex calculations. Some other 

examples for spreadsheet software are Google Sheets, Lotus Symphony, OpenOffice Calc, 

LibreOffice Calc, Quattro Pro, etc. 

 

7.2 FEATURES OF EXCEL 

 Autosum: This feature helps you to add the data in a number of adjacent cells 

automatically 

 

 Autofill: This feature allows you to quickly fill cells with repetitive or sequential data 

such as dates or serial numbers, and repeated text. Autofill can also be used to copy 

functions. You can also alter text and numbers with this feature. 

 

 Sort and Filter: These features help you to organize data so that it is easier to analyse 

it. Sorting helps you to arrange the data in ascending or descending order. Filter 

command is used to display the specific value that meets the certain criteria. 

 

 Automatic Calculation: This feature or predefined functions allow you to enter 

mathematical formulas ranging from simple arithmetic to complex statistics. There 

are many functions like SUM, AVERAGE, MAX, MIN, COUNT, CUBE, etc. to 

make calculations easily. 

 

 Data Analysis: This feature helps you to analyze your data in different ways other 

than the simple grids and lines. A spreadsheet program can automatically create 

graphics and charts from your data to compare and analyze the information easily. 
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 Automatic Report Generation and Distribution: This feature eliminates the need 

for manually generating reports and reduces the possibility of errors. It also allows to 

share and distribute the generated reports. 

 

 Charts can also be shown in a spreadsheet. 

 

 Reports can be generated in the form of charts (of the data). 

 

 

7.3 PARTS OF EXCEL WINDOW 

 

 

 

 Ribbon Controls 

It combines the original menu and toolbar(s) into one control, with various functions 

grouped into tabs and groups. The most important purpose was to make it easier for 

the user to discover all the functionality, instead of hiding it in long menus. The 

Ribbon also allows for prioritization of functionality, with the ability to use different 

sizes of buttons. 
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 Ribbon Tabs /Toolbar 

There are a series of elements that are part of each menu bar. On the selection of any 

menu, a series of command options/icons will display on a ribbon. For example, if 

you press the “Home” tab, you will see cut, copy, paste, bold, italic, underline, and 

etc., commands.  They are the top section of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout, Formula, Data, etc, are examples of ribbon 

tabs. 

 

 Ribbon Groups: 

They organize related commands; the name of each group appears below the Ribbon. 

For example, a group of commands related to fonts or group of commands related to 

alignment, etc. 

 

 Name box 

Show the location of the active cell, row or column. You can make more than one 

selection. 

 

 Formula bar 

It is a bar that allows you to observe, insert or edit the information/formula entered in the 

active cell. 

 

 Columns 

Columns are a series of boxes vertically organized in the entire sheet. It columns bar is 

located below the formula bar. The columns are listed with letters of the alphabet. Start 

with the letter A to Z, and then after Z, it will continue as AA, AB and so on. The 

maximum limit of columns is 16,384. 

 

 Rows  

It is that left part of the sheet where a sequence of numbers is expressed. Start with 

number one (1) and as we move the cursor down, more rows will be added. The 

maximum number of rows goes to 1,048,576. 
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 Cells 

Cells are those parallelepipeds that divide the spreadsheet into several segments that 

allow rows to be separated from columns. The first cell of a spreadsheet is represented by 

the initial letter of the alphabet and the number one (A1). 

 

 

7.4 WORKBOOKS 

A workbook is a file that contains one or more worksheets to help you organize data. You can 

create a new workbook from a blank workbook or a template. 

 

7.4.1 Create an Excel XP workbook: 

 Choose File New from the menu bar. 

 

 

 The New Workbook task pane opens on the right side of the screen. 

 

 

 

 Choose Blank Workbook under the New category heading. 

 A blank workbook opens in the Excel window. The New Workbook task pane 

is closed. 
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7.4.2 Saving a workbook 

Every workbook created in Excel must be saved and assigned a name to distinguish it from 

other workbooks. The first time you save a workbook, Excel will prompt you to assign a 

name through the Save As operation. Once the file is assigned a name, any additional changes 

made to the text, numbers, or formulas must be saved using the Save operation. 

To save a new workbook: 

 Choose File Save As from the menu bar. 

 

 

 The Save As dialog box appears. 

 Click the Save In: drop-down menu and locate where the file will be saved.  

Choose required directory and type a name for your file in the File 

Name: box. 

 Click the Save button. 

 

 

To save changes made to an existing workbook: 

 Choose File Save from the menu bar. 

OR 

 Click the Save button on the Standard toolbar. 
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7.4.3 Opening a workbook 

We can open any workbook that has previously been saved and given a name. 

To open an existing Excel XP workbook: 

 Choose File Open from the menu bar. 

 

 

 The Open dialog box opens. 

 

 

 In the Look in list, click the drive, folder, or Internet location that has the file 

you want to open. 

 In the folder list, open the folder that contains the file. Once the file is 

displayed, click the file you want to open. 

 Click the Open button. 

7.4.4 Closing a workbook 

To close an existing Excel XP workbook: 

 Choose File Close from the menu bar. The workbook in the Excel window 

is closed. 
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 Excel XP will prompt you to save information if anything has been typed between the 

last save and the time you close the file. 

 

 

7.5 WORKSHEETS  

7.5.1 Rows and columns 

A worksheet in Excel is made up of Rows and Columns. Intersection of a Row and column in 

an Excel worksheet is a rectangle called as a Cell. Cells store a value, a formula, or text. An 

Excel worksheet contains very large number of cells. A cell is a smallest building block of an 

Excel worksheet. 

 

 Rows in Excel worksheet 

Similar to a Row in any table, a Row in Excel worksheet runs horizontally. Rows in Excel 

worksheet are identified by Row numbers. Row numbers in Excel 2010 starts from 1 and 

ends in 1048576. 

 

 Columns in Excel worksheet 

Similar to a Column in any table, a Column in Excel worksheet runs vertically. Columns 

in Excel worksheet are identified by Column letters. Column letters in Excel 2010 starts 

from "A" and ends in "XFD". 

 

 Cells in Excel worksheet 

Intersection of a Row and column in an Excel worksheet is a rectangle called as a Cell. A 

Cell can store one data at a time. The data can be text, number, formula, date etc. 
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A Cell in Excel worksheet is identified by a Cell Address consisting of Column letter and 

Row number. Below image shows a Cell in Excel worksheet. 

 

The Cell shown below is the intersection of Column "C" and Row "5". Therefore the Cell 

address of cell shown below is "C5". 

 

The thick border outline around the selected Cell in above image indicates that it is the 

Active cell in Excel Worksheet. The Active cell is where the focus is on and where the 

data will be entered when a key is typed on keyboard. Below image shows the Active 

Cell as C5, which is hi-lighted with a thick border. The Cell address of Active cell is 

displayed in Cell Name box in Excel formula bar. 

 

7.5.2 Inserting and Deleting rows and columns and cells 

 Insert and Delete Columns and Rows 

You can insert and delete columns and rows. When you delete a column, you delete 

everything in the column from the top of the worksheet to the bottom of the 

worksheet. When you delete a row, you delete the entire row from left to right. 

Inserting a column or row inserts a completely new column or row. 

 
 

 To delete columns F and G: 

o Click the column F indicator and drag to column G. 

o Click the down arrow next to Delete in the Cells group. A menu appears. 

o Click Delete Sheet Columns. Excel deletes the columns you selected. 

o Click anywhere on the worksheet to remove your selection. 

 

 To delete rows 7 through 12: 

o 1. Click the row 7 indicator and drag to row 12. 

o Click the down arrow next to Delete in the Cells group. A menu appears. 

o Click Delete Sheet Rows. Excel deletes the rows you selected. 

o Click anywhere on the worksheet to remove your selection. 
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 To insert a column: 

o Click on A to select column A. 

o Click the down arrow next to Insert in the Cells group. A menu appears. 

o Click Insert Sheet Columns. Excel inserts a new column. 

o Click anywhere on the worksheet to remove your selection. 

 

 To insert rows: 

o Click on 1 and then drag down to 2 to select rows 1 and 2. 

o Click the down arrow next to Insert in the Cells group. A menu appears. 

o Click Insert Sheet Rows. Excel inserts two new rows. 

o Click anywhere on the worksheet to remove your selection 

 

 Delete a Cell Entry 

To delete an entry in a cell or a group of cells, you place the cursor in the cell or 

Select the group of cells and press Delete. 

o Select cells A1 to A2. 

o Press the Delete key. 

 

7.5.3 Entering labels and values  

Entering data into a spreadsheet is just like typing in a word processing program, but you 

have to first click the cell in which you want the data to be placed before typing the data. All 

words describing the values (numbers) are called labels. The numbers, which can later be 

used in formulas, are called values. 

First, place the cursor in the cell in which you want to start entering data. Type some data, 

and then press Enter. If you need to delete, press the Backspace key to delete one character at 

a time. 

We can also edit the cell by using the Formula bar. You change "Surya" to "Sri" as shown 

below. 

1. Move the cursor to cell A1. 

2. Click in the formula or entries area of the Formula bar, and change Surya to Sri. 

3. Press Enter. 

 

7.6 FORMATTING 

 

7.6.1 Adjusting row height and column width 

 

The excel column's minimum size is 0, maximum size is 255 and default size is 8.43 

The excel row's minimum size is 0, maximum size is 409 and default size is 15.00 
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7.6.1.1 Set a column to a specific width 

 Select the column or columns that you want to change. 

 On the Home tab, in the Cells group, click Format. 

 

 

 Under Cell Size, click Column Width. 

 In the Column width box, type the value that you want. 

 

 Click OK. 

 

 7.6.1.2 Set a row to a specific height 

Select the row or rows that you want to change. 

 On the Home tab, in the Cells group, click Format. 

 Under Cell Size, click Row Height. 

 In the Row Height box, type the value that you want. 
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 Click OK 

 

7.6.2 Formatting cell values 

 Select the cells that you wish to format 

 

 On the Home tab, in the Cells group, click Format. 

 When the Format Cells window appears, select the Number tab. In the Category 

listbox, select your format. A sample of your text will appear on the right portion 

of the window based on the format that you've selected. Click the OK button when 

you are done. 
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 In this example, we have chosen to format the content of the cells as a currency 

number. 

 

 

 

 

7.7 FORMULAS  

Formulas are playing a vital role in Excel spreadsheet. A formula uses standard mathematical 

symbols to operate on cell addresses and/or numbers. 

 

7.7.1 Operators used in formula 

A formula can be a combination of values (numbers or cell references) and mathematical 

operators into an algebraic expression. Mathematical operators include the following 

symbols: 

+ - Addition 

- - Subtraction 

* - Multiplication 
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/ - Division 

% - Percentage 

^ - Exponentiation (power) 

We can also use parentheses and decimal points, whenever we required in formula. 

For example to create a formula in cell D2 that adds a value entered in cell B2 by a value in 

cell C2, enter the following formula in cell D2:   = B2 + C2 

 To enter this formula in cell D2, follow these steps. 

o Select cell D2 

o Type the entire formula D2:   = B2 + C2 in the cell. 

o Press Enter 

Or do the following steps 

o Select cell D2 

o Type = (equal sign) 

o Select cell A2 in the worksheet by using the mouse or keyboard. This action 

takes places the cell reference B2 in the formula in the cell. 

o Type +  and  

o Select cell B2 in the worksheet by using the mouse or the keyboard. This 

action places the cell reference C2 in the formula. 

o Click the Enter box to complete the formula entry, while at the timekeeping 

the cell cursor in cell D2. 

o Excel displays the calculated answer in cell D2 and the formula D2:   = B2 + 

C2 in the formula bar. 

 

 

 Repeat the calculation for every cell in a column 

To do this select the cell with the formula and when you move the pointer to the lower right 

hand corner of the cell, the cursor changes to a bold plus (+) sign. Click and hold down the 
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mouse while you drag to highlight cells down the column to the last row of data. Every 

highlighted cell now contains the formula. Note: Display of #NA indicates problem(s) with 

the formula or the result is larger than the width of cell. 

 

7.7.2 Cell references in formula 

Cell references are often used when creating Excel worksheets and writing formulas. A key 

element of a formula is the cell reference, and there are three types of cell references. Cell 

reference means the cell to which another cell refers. For instance, if in B2 you have =B3, 

cell B2 is referring to cell B3. The cell reference in this example is B3.  

 

If we look at a formula such as = sum (B2:B10), the cell reference is B2:B10. The formula is 

telling Excel to sum or add all of the numbers starting in cell B2 through cell B10. Sometimes 

the cell reference may be referred to as the cell range because most references in a formula 

refer to multiple cells within a range.  

 

o Relative 

When you enter a cell reference or range into a formula, by default, the reference is 

relative. Relative cell references, when copied to another cell or across multiple cells, will 

change based on where you copy them.  

 

We have a sample worksheet with income, expenses and profit numbers for five different 

stores. Column B is titled Income, column C is titled Expenses, and column D is titled 

Profit. The formula in D3 for Store 1 calculates the profit. The formula is = sum (B3 - 

C3). This is a very basic formula that takes the income and subtracts the expenses. 

 

Imagine you want to copy the formula in D3, down the column for the other stores. When 

you copy the formula, the cell references will automatically change to reference the new 

row, row four, five, and six and so on. Instead of = sum (B3 - C3), you will get = sum (B4 

- C4). Relative references are especially convenient whenever you need to repeat the 

same calculation across multiple rows or columns. 

 

o Absolute 
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So, there may be times when we don't want the cell reference to change when copied to 

another cell or range of cells. This is where absolute cell references come to existance. to 

make absolute cell reference just add a dollar sign before the column letter and row 

number. For instance, = sum ($B$3 - $C$3). Unlike relative references, absolute 

references do not change when copied. You can use an absolute reference to keep a row 

or column constant. 

 

o Mixed 

Mixed references are tricky referencing. A dollar sign is used before the row or the 

column for mixed reference. Excel Mixed reference locks the column or the row behind 

which the dollar sign is applied. Mixed reference locks just one of the cells but not both. 

 

In other words, part of the reference in mixed referencing is a relative & part is absolute. 

They can be used for copying the formula across rows of columns and rows, eliminating 

the manual need for editing. 

 

 

 

7.8 FUNCTIONS  

A function is a special key word which can be entered into a cell in order to perform and 

process the data which is appended within brackets. 
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There is a function button on the formula toolbar  when we click with the mouse on it; a 

function offers assistance and useful prompts into a spreadsheet cell. Alternatively we can 

enter the function directly into the formula bar. 

A function involves four main needs: 

• Name of the function 

• The purpose of the function 

• The function needs what argument(s) in order to carry its assignment  

• The result of the function. 

 

A function is a built in set of formulas which starts with an = “equal to sign” such as = 

FunctionName (Data). The data (or argument in proper terminology) includes a range of 

cells. 

 

By using functions, you can quickly and easily make many useful calculations, such as 

finding an average, the highest number, the lowest number, and a count of the number of 

items in a list. Microsoft Excel has many functions that you can use. 

 

To use functions, you need to understand reference operators. Reference operators refer to a 

cell or a group of cells. There are two types of reference operators: range and union. 

A range reference refers to all the cells between and including the reference. A range 

reference consists of two cell addresses separated by a colon. The reference A1:A3 includes 

cells A1, A2, and A3. The reference A1:C3 includes cells A1, A2, A3, B1, B2, B3, C1, C2, 

and C3. 

A union reference includes two or more references. A union reference consists of two or 

more numbers, range references, or cell addresses separated by a comma. The reference 

A7,B8:B10,C9,10 refers to cells A7, B8 to B10, C9 and the number 10. 

 

Functions are prewritten formulas. Functions differ from regular formulas in that you supply 

the value but not the operators, such as +, -, *, or /. For example, we can use the SUM 

function to add.  

 

When using a function, remember the following: 

 Use an equal sign to begin a formula. 
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 Specify the function name. 

 Enclose arguments within parentheses. Arguments are values on which you want to 

perform the calculation. For example, arguments specify the numbers or cells you 

want to add. 

 Use a comma to separate arguments. 

 

Example: 

 =SUM(4,15,A1,D2:E8) 

In this function, known as the SUM function: 

 The equal sign begins the function. 

 SUM is the name of the function. 

 4,15,A1 and D2:E8 are the arguments. Parentheses enclose the arguments. 

 Commas separate the arguments. 

 

After we type the first letter of a function name, the AutoComplete list appears. We can 

double-click on an item in the AutoComplete list to complete our entry quickly. Excel will 

complete the function name and enter the first parenthesis. 

 

7.8.1 Mathematical and Statistical Functions 

Function Output 

ABS The absolute value of a number 

AVERAGE The average or arithmetic mean for a group of numbers 

COUNT The number of cell locations in a range that contain a numeric character 

COUNTA The number of cell locations in a range that contain a text or numeric 

character 

MAX The highest numeric value in a group of numbers 

MEDIAN The middle number in a group of numbers (half the numbers in the group 

are higher than the median and half the numbers in the group are lower 

than the median) 

MIN The lowest numeric value in a group of numbers 

MODE The number that appears most frequently in a group of numbers 
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PRODUCT The result of multiplying all the values in a range of cell locations 

SQRT The positive square root of a number 

STDEV.S The standard deviation for a group of numbers based on a sample 

SUM The total of all numeric values in a group 

 

Examples: 

 

AVERAGE() 

 

The AVERAGE function is used to calculate the average of a series of numbers. 

 

 Enter values 150, 85,  and 65 in cells B1,B2 and B3 respectively. 

 Move to cell A6. 

 Type Average. Press the right arrow key to move to cell B6. 

 Type =AVERAGE(B1:B3). 

 Press Enter. The average of cells B1 to B3, which is 21, appears. 

 

 

ABS()  

 

ABS() function returns the absolute value of a number. The absolute value of a 

number is the number without its sign. 

Syntax: ABS(number) 

where Number is the real number of which you want the absolute 

value. 

=ABS(2)  Absolute value of 2   2 

=ABS(-2)  Absolute value of -2   2 

=ABS(A2)  Absolute value of -4   4 

 

SUM()  

 

SUM() function returns the sum of values supplied. These values can be numbers, cell 

references, ranges, arrays, and constants, in any combination. SUM can handle up to 

255 individual arguments. 

 

=SUM (number1, [number2], [number3], ...) 

where  number1 - The first value to sum,  number2 - [optional] The second value to 

sum and number3 - [optional] The third value to sum. 
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7.8.2 Logical Functions 

 

Function Description 

AND function Returns TRUE if all of its arguments are TRUE 

FALSE function Returns the logical value FALSE 

IF function Specifies a logical test to perform 

IFERROR function Returns a value you specify if a formula evaluates to an 

error; otherwise, returns the result of the formula 

IFNA function Returns the value you specify if the expression resolves to 

#N/A, otherwise returns the result of the expression 

NOT function Reverses the logic of its argument 

OR function Returns TRUE if any argument is TRUE 

TRUE function Returns the logical value TRUE 

XOR function Returns a logical exclusive OR of all arguments 

 

IF Function 

Returns one value if a condition you specify evaluates to TRUE and another value if it 

evaluates to FALSE. 

Syntax: IF(logical_test,value_if_true,value_if_false) 

Logical_test is any value or expression that can be evaluated to TRUE or FALSE. For 

example, A10=100 is a logical expression; if the value in cell A10 is equal to 100, the 

expression evaluates to TRUE. Otherwise, the expression evaluates to FALSE. 

Value_if_true is the value that is returned if logical_test is TRUE. 

Value_if_false is the value that is returned if logical_test is FALSzE. 

up to 64 IF functions can be nested as value_if_true and value_if_false arguments to 

construct more elaborate tests. 

The IF function can be read as: “If Logical_test then Value_if_true otherwise Value_if_false” 

Example 
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Formula Description (Result) 

=IF(A2<50,"FAIL","PASS") 
Assigns either a pass or fail remark to the 

first score (FAIL) 

=IF(A2>89,"A",IF(A2>79,"B", 

IF(A2>69,"C",IF(A2>59,"D","F")))) 

Assigns a letter grade to the first score (F) 

=IF(A3>89,"A",IF(A3>79,"B", 

IF(A3>69,"C",IF(A3>59,"D","F")))) 

Assigns a letter grade to the second score 

(A) 

=IF(A4>89,"A",IF(A4>79,"B", 

IF(A4>69,"C",IF(A4>59,"D","F")))) 

Assigns a letter grade to the third score (C) 

 

AND Function: Returns TRUE if all its arguments are TRUE; returns FALSE if one or more 

argument is FALSE. 

Syntax 

AND(logical1,logical2, ...) 

Logical1, logical2, ... are 1 to 255 conditions you want to test that can be either TRUE or 

FALSE. 

 

7.8.3 Text functions 

Function Description 

ASC function Changes full-width (double-byte) English letters or katakana 

within a character string to half-width (single-byte) characters 

CHAR function Returns the character specified by the code number 

CLEAN function Removes all nonprintable characters from text 

CODE function Returns a numeric code for the first character in a text string 

CONCAT function Combines the text from multiple ranges and/or strings, but it 

doesn't provide the delimiter or Ignore Empty arguments. 

CONCATENATE Joins several text items into one text item 
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function 

DOLLAR function Converts a number to text, using the $ (dollar) currency format 

EXACT function Checks to see if two text values are identical 

LEN, LENB functions Returns the number of characters in a text string 

LOWER function Converts text to lowercase 

PROPER function Capitalizes the first letter in each word of a text value 

REPLACE function Replaces characters within text 

SUBSTITUTE function Substitutes new text for old text in a text string 

TEXT function Formats a number and converts it to text 

TRIM function Removes spaces from text 

UPPER function Converts text to uppercase 

VALUE function Converts a text argument to a number 

 

ASC() 

Syntax: ASC(text) 

The ASC function syntax has the following arguments: 

Text    Required. The text or a reference to a cell that contains the text you want to 

change. If text does not contain any full-width letters, text is not changed. 

Example 

=ASC("Surya") equals "Surya" 

 

CHAR() 

Returns the character specified by a number. Use CHAR to translate code page numbers you 

might get from files on other types of computers into characters. 

Syntax: CHAR(number) 

Number    Required. A number between 1 and 255 specifying which character you want. The 

character is from the character set used by your computer. 

 

=CHAR(65) Displays the character represented by 65 in the computer's character set. A 

 

=CHAR(33) Displays the character represented by 33 in the computer's character set. ! 

 

 



Centre for Distance Education                           7.24                  Acharya Nagarjuna University  

 

 

7.9 CHARTS 

In Microsoft Excel, We can represent numbers in a chart. On the Insert tab, you can choose 

from a variety of chart types, including column, line, pie, bar, area, and scatter. The basic 

procedure for creating a chart is the same no matter what type of chart you choose. As you 

change your data, your chart will automatically update. 

We can select a chart type by choosing an option from the Insert tab's Chart group. After you 

choose a chart type, such as column, line, or bar, you choose a chart subtype. For example, 

after you choose Column Chart, you can choose to have your chart represented as a two-

dimensional chart, a three-dimensional chart, a cylinder chart, a cone chart, or a pyramid 

chart. There are further sub-types within each of these categories. As you roll your mouse 

pointer over each option, Excel supplies a brief description of each chart sub-type. 

 

 Create a Chart 

To create a chart first we have to create a worksheet with data .  

Example: 

 

After you have created the worksheet, you are ready to create your chart. 

 Create a Column Chart 

1. Select cells A3 to D6. You must select all the cells containing the data you want in your 

chart. You should also include the data labels.  

2. Choose the Insert tab. 

3. Click the Column button in the Charts group. A list of column chart sub-types types 

appears. 

4. Click the Clustered Column chart sub-type. Excel creates a Clustered Column chart and the 

Chart Tools context tabs appear. 
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 Apply a Chart Layout 

Context tabs are tabs that only appear when you need them. Called Chart Tools, there are 

three chart context tabs: Design, Layout, and Format. The tabs become available when you 

create a new chart or when you click on a chart. You can use these tabs to customize your 

chart. 
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1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the Quick Layout button in the Chart Layout group. A list of chart layouts 

appears. 

4. Click Layout  

5. Excel applies the layout to your chart. 

 

 Change the Style of a Chart 

A style is a set of formatting options. You can use a style to change the color and format of 

your chart. Excel 2007 has several predefined styles that you can use. They are numbered 

from left to right, starting with 1, which is located in the upperleft corner. 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the More button in the Chart Styles group. The chart styles appear. 

4. Click required Style then excel applies the style to your chart. 

 

 Change the Size and Position of a Chart 

When you click a chart, handles appear on the right and left sides, the top and bottom, and the 

corners of the chart. You can drag the handles on the top and bottom of the chart to increase 

or decrease the height of the chart. You can drag the handles on the left and right sides to 

increase or decrease the width of the chart. You can drag the handles on the corners to 

increase or decrease the size of the chart proportionally. You can change the position of a 

chart by clicking on an unused area of the chart and dragging. 

1. Use the handles to adjust the size of your chart. 

2. Click an unused portion of the chart and drag to position the chart beside the data. 

 

 Move a Chart to a Chart Sheet 

By default, when you create a chart, Excel embeds the chart in the active worksheet. 

However, you can move a chart to another worksheet or to a chart sheet. A chart sheet is a 

sheet dedicated to a particular chart. By default Excel names each chart sheet sequentially, 

starting with Chart1. You can change the name. 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab.x 
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3. Click the Move Chart button in the Location group. The Move Chart dialog box 

appears. 

4. Click the New Sheet radio button. 

5. Type Student Enrollment to name the chart sheet. Excel creates a chart sheet named 

Toy Sales and places your chart on it. 

 

 

 

 

 Change the Chart Type 

Any change you can make to a chart that is embedded in a worksheet, you can also make to a 

chart sheet. For example, you can change the chart type from a column chart to a bar chart. 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click Change Chart Type in the Type group. The Chart Type dialog box appears. 

4. Click Bar. 

5. Click Clustered Horizontal Cylinder. 

6. Click OK. Excel changes your chart type. 
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7.10 SUMMARY 

Microsoft Excel is a software program included in the Microsoft Office suite. It is 

used to create spreadsheets, which are documents in which data is laid out in rows and 

columns. Spreadsheets present tables of values arranged in rows and columns that can be 

manipulated mathematically using both basic and complex arithmetic operations and 

functions. MS Excel is widely used for various purposes because the data is easy to save, and 

information can be added and removed without any discomfort and less hard work. 

 

7.11 TECHNICAL TERMS 

Workbook, Worksheet, Column, Cell, Row, Spreadsheet, Formula, Function. 

 

7.12 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1) What are the different Math, String functions that are available in Excel. Explain 

them with suitable syntax and example. 

2) Describe the steps to align data in cells. Explain the use of chart wizard. 

3) Explain the steps to create chart on a separate sheet and to print it. Explain the 

steps adjust and hide column. 

 

 Short Notes:   

1. Write any five keyboard shortcut keys in MS-Excel 

2. Write the features of spread sheet? 

3. What are the various chart options available in MS-Excel 

4. Write down the steps involved in copying data with drag and drop in excel worksheet 

 

7.13   SUGGESTED READINGS 

1. MS-Office S.S. Srivastava 

2. Microsoft Office 2007 Fundamentals, 1st Edition By Laura Story, Dawna Walls 

 

 

AUTHOR: Dr. UDUGA SURYA KAMESWARI 

 

 



LESSON- 8 

Microsoft PowerPoint 

 

AIMS AND OBJECTIVES 

 

After reading this chapter, the student will be able to do the following in MS Power Point: 

 Understand the basic features of Microsoft Powerpoint 

 Create, edit, save, and print presentations. 

 Format presentations and add a graphic to a presentation. 

 Create and manipulate simple slide shows with outlines and notes. 

 Create slide presentations that include text, graphics, animation, and transitions. 

 Use design layouts and templates for presentations. 

 

STRUCTURE 

8.1 Introduction 

8.2 Features of Power Point 

8.3 Parts of Power Point Window 

 8.3.1 Creating a presentation 

 8.3.2 Saving a presentation 

 8.3.3 Opening a presentation 

8.4 Working with Slides 

 8.4.1 Inserting slides 

8.4.2 Deleting slides 

8.4.3 Copying slides 

8.4.4 Editing Text 

8.5  Formatting and Modifying Presentations 

 8.5.1 Slide Transition 

 8.5.2 Slide Animation 

 8.5.3 Inserting music or sound on a slide. 

8.6 Viewing Slide Show 

8.7 Summary 

8.8 Technical Terms 

8.9 Self-Assessment Questions 

8.10 Suggested Readings 
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8.1 INTRODUCTION 

MS PowerPoint is a program that is included in the Microsoft Office suite.  The software 

allows users to create anything from basic slide shows to complex presentations.  

PowerPoint is often used to create business presentations, but can also be used for 

educational or informal purposes. PPT is a powerful, easy-to-use presentation graphics 

software program that allows you to create professional-looking electronic slide shows.  

Presentation is a combination of various slides depicting a graphical and visual interpretation 

of data, to present information in a more creative and interactive manner. 

The file extension of a saved Power Point presentation is “.pptx”.   

 

8.2 FEATURES OF POWER POINT 

 Easy to present and maintain eye contact with a large audience by simply advancing the 

slides with a keystroke, eliminating the need for handouts to follow the message. 

 

 The creation of a presentation is now a more fluid process from beginning to end. 

 

 Easy to modify compared to other visual aids, such as charts, and easy to drag and drop 

slides to re-order presentation. 

 

 Simple bullet points: it can reduce complicated messages to simple bullet points. Bullet 

points are a good basis for a presentation and remind the speaker of main points and the 

organization of the message. 

 

 Easy to create a colorful, attractive design: using the standard templates and themes, you 

can create something visually appealing, even if you do not have much knowledge of 

basic graphic design principles. 

 

 The slide template design gallery is very graphical, and your presentation changes 

dynamically as you browse the gallery. 

 

 SmartArt makes striking flowcharts, Venn diagrams and relationship models. 

 

 Easy to modify: when compared to other visual aids such as charts, posters, or objects, it 

is easy to modify. 

 

 Easily re-order presentation: with a simple drag and drop or using key strokes, you can 

move slides to re-order the presentation. 
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8.3 PARTS OF A POWERPOINT WINDOW 

 

 

 
 

1. File menu and backstage view 

 When we click the File menu (the equivalent of the Office Button in PowerPoint 

2007), we can see the new backstage view that contains all the creation, save, share, and 

print options for your presentations. 

 

2. Quick Access Toolbar 

Also known as the QAT, this is a customizable toolbar placed by default on the top of 

Ribbon, you can add icons for your often used commands to this toolbar. The QAT can 

also be placed below the Ribbon. 

 

3. Ribbon 

The Ribbon has tabs which in turn contain groups of buttons for various options, 

some groups also contain galleries  

 

 

4. Slides/Outline Pane 

Normally placed on the left side of the interface, this pane contains two tabs, the 

Slides tab and the Outline tab. The Slides tab shows thumbnails of all the slides in the 

open presentation. The Outline tab shows the same slides in outline view. 

 

5. Status Bar 

A horizontal strip that provides information about the opened presentation like slide 

number, applied Theme, etc. It also includes the view and zoom options. 
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6. Notes Pane 

Directly below the active slide, this is where you input speaker notes for the current 

slide. None of this content is visible on the actual slide while presenting, although it is 

visible in both Notes Page view and Presenter view 

 

7. View Buttons 

Essentially there are three view buttons on the status bar displayed towards the left of 

the zoom-in and zoom-out options: 

Normal View - Clicking this enables Normal view, Shift-clicking this gets you to 

Slide Master View. 

Slide Sorter View - Clicking this displays zoomable thumbnails of every slide in the 

open presentation. Shift-clicking this button gets you to Handout Master view. 

Slide Show from current slide - Show the presentation as a full screen slideshow from 

the current selected slide. Shift-clicking brings up the Set Up Show dialog box 

 

8. Slide Area 

Displays the active slide. 

 

9. Task Pane 

The Task Pane contains more options and appears when you choose an option in one 

of the Ribbon tabs, for example if you click the Clip Art button on the Insert tab of the 

Ribbon, the Clip Art task pane opens 

 

10. Mini Toolbar 

This toolbar is not shown in the figure above, it's a semitransparent floating toolbar 

that spawns right next to the cursor, and it is also available instantly with a right-click 

 

 

8.3.1 Creating a presentation 

When we open PowerPoint from the Start menu, a new presentation with one slide 

appears by default. We can also create a new presentation while PowerPoint is already 

open. 

 

 Click the Microsoft Office button, and choose New from the menu. 
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 The New Presentation dialog box will appear. Blank presentation is selected 

by default. 

 

 
 

 Click Create, and a new presentation will open in the PowerPoint window. 

 The default slide that appears when you create a new presentation is a Title 

Slide layout. 

 

8.3.2 Saving a presentation 

If you are saving a document for the first time, you will need to use the Save As 

command; however, if you have already saved a presentation, you can use the Save 

command. 

 
8.3.2.1 To use the Save As command: 

 

 Click the Microsoft Office button. 

 Select Save As. A menu will appear. 

 Select the type of file you want to save the presentation as. 

 

 The two most commonly used file types are: 

PowerPoint Presentation: This saves the presentation as a 2007 

PowerPoint file. Only users with PowerPoint 2007 or the compatibility 

pack can view the file without possibly losing some of the formatting. 

PowerPoint 97-2003 Presentation: This saves the presentation so it is 

compatible with some previous versions of PowerPoint. If you will be 

sending the presentation to someone who does not have Office 2007, 

you should use this file type. 
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 The Save As dialog box will appear. Select the location where you want to 

save the document using the drop-down menu. 

 

 
 

 Enter a name for the document. 

 Click the Save button. 

 
8.3.2.2. To use the Save command: 

 Click the Microsoft Office button. 

 Select Save from the menu. 

 Using the Save command saves the document in its current location using the 

same file name. 

 

8.3.3 Opening a presentation 

If you want to work once again in your previously saved presentation, you can open the same 

as follows:  
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 Select Open option from the Microsoft Office button menu. 

 
 

 Open dialog box will display on the screen. 

 Select your file from the list displayed in the open dialog box. 

 Click Open button. 

 

 

8.4 WORKING WITH SLIDES 

 

8.4.1 Inserting slides 

There are three ways to add a slide in PowerPoint.  

 On the Home tab, in the Slides group, click New Slide. 
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 Right-click on the slide from the slide tabs and selects New Slide on the pop-

up menu. 

 

 
 

 Click on a slide from the slides tab and hit the enter key. 
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8.4.2 Deleting slides 

 Right-click the slide that you want to delete.  

 Click Delete Slide. 

 

8.4.3 Copying slides 

 In the pane that contains the Outline and Slides tabs, click the Slides tab. 

 Select the slide that you want to copy by doing one of the following: 

o To select a single slide, click it. 

o To select multiple sequential slides, click the first slide, press SHIFT, and then 

click the last slide that you want to select. Feel free also to make use of the 

SHIFT + CURSOR down command which allows you to select the slides 

sequentially one by one until you get to the last preferred slide. You can press 

CURSOR UP while still holding onto the SHIFT button to go up and deselect 

the last slide. 

o To select multiple non-sequential slides, press CTRL, and then click each slide 

that you want to select. 

 Right-click one of the selected slides, and then click Copy. 

 In the destination presentation, on the Slides tab, right-click the slide that you want 

your copied slides to follow, and then click Paste. You can also use the paste shortcut 

CTRL + V to save time 

 To retain the original design of the copied slides, click the Paste Options button 

Button image, which appears near the pasted slides on the Outline or Slides tab in 

Normal view, or in the Slides pane, and then click Keep Source Formatting. 

 

8.4.4 Editing Text 

Slide layouts contain placeholders. The dotted border represents placeholders; just click 

inside the border and you can add text or insert objects. The slide’s layout will determine the 

position and size of placeholders. 

 Click inside a text placeholder. 

 Type or Paste the Text.  
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If your text exceeds the size of the placeholder, PowerPoint reduces the font size and line 

spacing incrementally as you type, to make the text fit. 

 

 

8.5  FORMATTING AND MODIFYING PRESENTATIONS 

 

8.5.1 Slide Transition 

The term animation in PowerPoint refers to the movements of text and objects on the slide. A 

slide transition is how one slide is removed from the screen and the next slide is displayed 

during a presentation. PowerPoint offers many entertaining and different slide transition 

schemes. 

 To apply a transition to one slide: 

o Select the slide you want to modify. 

o Select the Animations tab. 

o Locate the Transition to This Slide group. By default, No Transaction is 

applied to each slide. 

 

o Click the More drop-down arrow to display all available transition effects. 

 

 

 
 

o Click a slide transition effect to apply it to the selected slide. 
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o Hover over a slide transition effect to see a live preview of the effect on the 

slide. 

 apply a slide transition to all slides: 

o Select the slide you want to modify. 

o Select the Animations tab. 

o Locate the Transition to This Slide group. By default, No Transition is applied 

to each slide. 

o Click the More drop-down arrow to display all transition effects. 

o Click a slide transition effect to apply it to the selected slide. 

o Click Apply To All to apply the transition to all slides in the presentation. 

 

 
A star Play Animations icon will appear beneath any slide that has a transition effect 

applied to it, as well as any slide that uses animation effects for text or objects. The 

icon is visible on the Slides tab in the task pane on the left and in Slide Sorter view. 

Click the star Play Animations icon to preview the animation or transition effect. 

 

 Modifying transitions 

 To set slide transition speed: 

o Apply a slide transition effect to a slide. 

o Click the Transition Speed drop-down menu in the Transition to This Slide 

group on the Animations tab. 

o Select a menu option to apply the transition speed to the selected slide. 

 
o You can set the transition speed when you apply the transition effect, or you 

can return to the Animations tab and apply it later. If you want to apply the 

transition effect and transition speed to all slides, Click Apply to All. 

 To remove a slide transition effect: 

o Select the slide you want to modify. 

o Select the Animations tab. 

o Click No Transition in the Transition to This Slide group. 
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o Repeat this process for each slide you want to modify. 

OR 

o Click Apply To All to remove the slide transition effect from each slide in the 

presentation. 

 

 To set timing for slides: 

o View the slides in Slide Sorter view. 

o Select a slide. 

o Select the Animations tab. 

o Locate the Advance Slide section of the Transition to This Slide group. 

o Enter the time in the Automatically After field. Use the arrows or type the 

number. 

 
o Select another slide and repeat the process until all desired slides have the 

timing set. 

o If you want to apply the same transition effect and timing for each slide, set 

the transition effect timing for one slide and click Apply to All. 

 

8.5.2 Slide Animation 

PowerPoint animation is a form of animation which uses Microsoft PowerPoint and similar 

programs to create a game or movie. The artwork is generally created using PowerPoint's 

AutoShape features, and then animated slide-by-slide or by using Custom Animation. 

 

 To apply a default animation effect: 

o Select the text or object on the slide you want to animate. 

o Select the Animations tab. 

o Click the Animate drop-down menu in the Animations group to see 

the animation options for the selection. The options change based on the 

selected item. 

 

 
o Move your cursor over each option to see a live preview of the animation on 

the slide. 

o Click an option to select it. 
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 To apply a custom animation effect: 

o Select the text or object on the slide you want to animate. 

o Select the Animations tab. 

o Click Custom Animation in the Animations group. The Custom Animation 

task pane will appear on the right. 

 

 
 

o Click Add Effect in the task pane to add an animation effect to the selected text 

or object. 

 

 
 

o Select Entrance, Emphasis, Exit, or Motion Path to display a submenu of 

animation effects for the category. 
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Entrance: Changes how the selected item appears on the page 

Emphasis: Draws attention to the selected item while the slide is displayed 

Exit: Changes the way the selected item disappears from the slide 

Motion Path: Animates the selected item so it moves to a specific place on the screen 

 

o Select an animation effect to apply it. 

 

o The animation will display on the selected item on the slide and will appear 

listed in the Custom Animation task pane. 

 

 
 

o A number label appears on the slide next to the animated object. A matching 

number label also appears next to the animation in the Custom Animation task 

pane list. 

o Drop-down menus appear at the top of the Custom Animation task pane. You 

can define the animation effect in greater detail here. 

o The star Play Animations icon appears beneath the slide on the Slides tab in 

the task pane on the left. It indicates that the slide has an animation effect. 

o Select More Effects or More Motions Paths from the menu to see more 

animation effect options. 

 

 To modify a default or custom animation effect: 

o After you apply an animation effect, drop-down menus will appear at 

the top of the Custom Animation task pane. The menus vary based on the 

animation effect. 

o Select an option from a drop-down menu to change the default setting. 
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o Repeat until all menu options are at desired settings. 

 

 To remove an animation effect: 

o Select the text or object on the slide you want to modify. 

o Select the Animations tab. 

o Click Custom Animation in the Animations group. The Custom Animation 

task pane will appear on the right. 

o Select the animation in the Custom Animation task pane list, if it is not already 

selected. 

o Click Remove. The animation label will disappear from the slide and from the 

Custom Animation task pane list. 

 

 

 

 To apply a different animation effect: 

o Select the text or object on the slide you want to modify. 

o Select the Animations tab. 

o Click Custom Animation in the Animations group. The Custom Animation 

task pane will appear on the right. 

o Select the animation in the Custom Animation task pane, if it is not already 

selected. 

o Click Change. 

o Select an Entrance, Emphasis, Exit, or Motion Path animation effect. 
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o New drop-down menus with default settings will appear at the top of the 

Custom Animation task pane. 

 

 

 To preview an animation effect: 

o Select the text or object you want to modify on 

the slide. 

o Select the Animations tab.  

o Click Custom Animation in the Animations 

group. The Custom Animation task pane will 

appear on the right. 

o Select the animation in the Custom Animation 

task pane list. 

o Click Play at the bottom of the task pane to see 

a preview of the animation in Normal view. 

 OR 

o Click Slide Show to see the animation in Slide 

Show view. Press the Esc key to return to 

Normal view. 

 

 

To animate text with a default animation: 

o Select the text box or text you want to animate on the slide. 

o Select the Animations tab. 
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o Click the Animate drop-down menu in the Animations group to see 

the animation effects for the selected text. The effects vary based on the 

selected item. 

o Select an animation effect. 

 

 
 

 

 All At Once: The selected text appears all at once. The entire text is 

labeled with one number on the slide. Click the drop-down arrow in 

the task pane to expand the contents and see that the text is labeled 

with one number. 

 
 

 By 1st Level Paragraphs: The text will appear bullet by bullet, or 

paragraph by paragraph. Each level of text is labeled with a different 

number on the slide. Click the drop-down arrow in the task pane to 

expand the contents and see that the text is labeled with multiple 

numbers. 
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 To modify an animation effect in other ways: 

o Select an animation effect in the Custom Animation task pane list. 

o Click the arrow to display a drop-down menu. 

o Select Effects Options or Timing. A dialog box will appear. 

o In the dialog box, add enhancements such as sounds, and define what happens 

after the animation effect is applied to the selected item. 

 

o The dialog box name is based on the animation effect name. In the example 

above, the animation effect is Fade. The tabs and options on the tabs will vary 

based on the animation effect that is being modified. 

 

 To reorder animation effects. 

o Select the Animations tab. 

o Click Custom Animation in the Animations group. 

o Select the animation effect you want to move in the Custom Animation task 

pane list. 

o Click the arrows at the bottom of the task pane to reorder the selected 

animation effect. 
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8.5.3 Inserting music or sound on a slide. 

 

 Apply a slide transition effect to a slide. 

 Click the Transition Sound drop-down menu in the Transition to This Slide group on 

the Transitions tab. 

  

 
 

 Select a sound to apply it to the selected slide. 

 Click Apply To All if you want to apply the transition effect and transition sound to all 

slides. 

 

 
 

 

8.6 Viewing Slide Show 

When you are done creating slides, you may want to look at your presentation to make sure 

that everything you see is visible. PowerPoint gives you the ability to view the display in four 

ways depending on what task you are completing. For example, if you use your slides to talk 

to an audience PowerPoint is often used — you may want to practice your presentation and 

view your slides in a slideshow view. 

 

8.6.1 Slide views 

It's important for you to be able to access the different PowerPoint slide views and use them 

for various tasks. Three of the four views are visible from the Normal default view. The slide 

view commands are located on the bottom-right side of the PowerPoint window in Normal 

view. Click a view command to switch to that view. 

 Normal view: This view is where you create and edit your slides. You can also move 

slides in the Slides tab on the task pane on the left. 
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 Slide Sorter view: Miniature slides are arranged on the screen in this view. You can drag 

and drop slides easily to reorder them, and you can see more slides at one time. This is a 

good view to use to confirm that you have all the necessary slides and that none have 

been deleted. 

 

 

 Slide Show view: This view fills the computer screen with a slide and is what the 

audience will see when they view the presentation. The Slide Show view has an 

additional menu that allows you to navigate the slides, as well as other features you can 

use during a presentation. 
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Use the arrow keys, Page Up and Page Down keys, spacebar, and Enter key to move through 

the slides in Slide Show view. Press the Esc key to end a slide show. 

 The slide show menu 

Arrows: The forward arrow displays the next slide, while the back arrow displays the 

previous slide. 

 

Menu icon: Click the menu icon, and a menu appears that gives you the option to move 

to the next or previous slide, jump to a specific slide, change your screen options, or end 

the show. 

 

Pen icon: Click the pen icon, and a menu appears that allows you to change your cursor 

to a ballpoint pen, felt-tip pen, or highlighter, as well as to choose the color of the pen. 

This allows you to annotate your slides and make notes while you present to an audience. 
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 Notes Page view 

The fourth view is Notes Page view. It is not one of the view commands included at the 

bottom of Normal view; however, it can be accessed from the View tab. Notes Page view 

provides a space for presentation notes, which are often called speaker notes. The notes can 

be added to the presentation from this view. You can enter your speaker notes directly into 

the text placeholder in Notes Page view, or while in Normal view you can enter your notes in 

the area below the slide. 

To change to Notes Page view: 

Select the View tab. 

Locate the four view commands on the left side of the Presentation Views group. 

 

 

 

Click Notes Page view. 
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8.7 SUMMARY 

Microsoft PowerPoint is a computer software package that displays information in the form 

of a slide show.  PowerPoint presentations consist of a number of individual pages or “slides” 

with individual slides containing text, graphics, sound, video, or other objects that can be 

arranged by the presenter. A PowerPoint presentation can be automatically controlled by pre-

programming transitions from one slide to another, or manually controlled by a user. 

 

8.8 TECHNICAL TERMS 

 Power point slide, slide master, slide sorter, Graphics, Sound, Video, Custom 

Animations, Transition, slide show view. 

 

 

8.9 SELF ASSESSMENT QUESTIONS 

Essay questions: 

1) What is a presentation? Explain steps to create a presentation in MS PowerPoint. 

2) What are the various views in PowerPoint 

3) Explain about slide transition 

4) Explain various steps to apply animation effects to objects. 

     Short Notes:   

1.  What is side layout? List any two types of  Side layouts 

2.  Write steps to apply motion effect to an object. 

3.  Differentiate slide design and auto content wizard. 

4.  Write any two applications of power point 

 

8.10   SUGGESTED READINGS 

1. MS-Office S.S. Shrivastava 

2. Microsoft Office 2007 Fundamentals, 1st Edition By Laura Story, Dawna Walls 
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